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Getting Started

This section contains the following topics:

What Is the Embedded Target for
Infineon C166 Microcontrollers?
(p. 1-3)

Prerequisites (p. 1-5)

Using This Guide (p. 1-6)

Installing the Embedded Target
for Infineon C166 Microcontrollers
(p. 1-8)

Hardware and Software
Requirements (p. 1-9)

Setting Up and Verifying Your
Installation (p. 1-14)

Setting Up Your Target Hardware
(p. 1-16)

Overview of the product and the
use of the Embedded Target for
Infineon C166® Microcontrollers in
the development process.

What you need to know before using
the Embedded Target for Infineon
C166 Microcontrollers.

Suggested path through this
document to get you up and running
quickly with the Embedded Target
for Infineon C166 Microcontrollers.

Installation of the product.

Hardware platforms supported by
the product; development tools (e.g.,
compilers, debuggers) required for
use with the product.

Overview of setting up your
development tools and hardware to
work with the Embedded Target for
Infineon C166 Microcontrollers, and
verifying correct operation.

Port connections and jumper
settings.
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Setting Target Preferences (p. 1-17)

Creating a Make Variables Reference
File for the Build Process (p. 1-19)

Supported Blocks and Data Types
(p. 1-22)

Overview of C166 Configuration
Parameters (p. 1-23)

Configuring environmental settings
and preferences associated with the
Embedded Target for Infineon C166
Microcontrollers.

This section explains the purpose
of the Make Variables Reference
File file specified in the C166
Target Preferences. You will need
to understand these and generate
new files if you want to change the
default settings supplied with the
Embedded Target for Infineon C166
Microcontrollers.

Requirements and restrictions.

Links to information about C166
Options in the Configuration
Parameters dialog.



What Is the Embedded Target for Infineon C166 Microcontrollerse

What Is the Embedded Target for Infineon C166
Microcontrollers?

The Embedded Target for Infineon C166® Microcontrollers is an add-on
product for use with the Real-Time Workshop® Embedded Coder. It provides
a set of tools for developing embedded applications for the C166 family of
processors. This includes derivatives such as Infineon C167 and XC16x, and
ST Microelectronics ST10 (http://www.us.st.com).

Used in conjunction with Simulink®, Stateflow®, and the Real-Time Workshop
Embedded Coder, the Embedded Target for Infineon C166 Microcontrollers
lets you

Design and model your system and algorithms.

Compile, download, run and debug generated code on the target hardware,
seamlessly integrating with industry-standard compilers and development
tools for the C166 microcontroller.

Use rapid prototyping techniques to evaluate performance and validate
results obtained from generated code running on the target hardware.

Deploy production code on the target hardware.

Feature Summary

Automatic generation of themain program including singletasking or
preemptive multitasking scheduler

Scheduler is configurable to allow temporary overruns

Automated build procedure including starting debugger or download utility
Support for integer, floating-point, or fixed-point code

Driver blocks for serial transmit and receive

Driver blocks for CAN message transmit and receive

Task execution time profiling

Examples to show you how to integrate your own driver code

Fully integrated with Tasking toolchain

1-3
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¢ Enhanced HTML report generation provides analysis of RAM/ROM usage;
this is in addition to the standard HTML report generation that shows
optimization settings and hyperlinks to generated code files

e Support for CAN Calibration Protocol



Prerequisites

Prerequisites

This document assumes you are experienced with MATLAB®, Simulink,
Real-Time Workshop, and the Real-Time Workshop Embedded Coder.

Minimally, you should read the following from the “Getting Started with
Real-Time Workshop” section of the Real-Time Workshop documentation:

o “What Is Real-Time Workshop?” This section introduces general concepts
and terminology related to Real Time Workshop.

* “Working with Real-Time Workshop” This section provides several hands-on
exercises that demonstrate the Real-Time Workshop user interface, code
generation and build process, and other essential features.

You should also familiarize yourself with the Real-Time Workshop Embedded
Coder documentation.

In addition, if you want to understand and use the device driver blocks in
the Embedded Target for Infineon C166 Microcontrollers library, you should
have at least a basic understanding of the architecture of the C166. The
C166 User’s Manual (or corresponding document for your C166 derivative
processor) is required reading. The MathWorks recommends that you read
the introduction to the C166 microcontroller. You can find this document
by searching the Infineon Web site for the C166 family of microcontrollers,
at the following URL:

http://www.infineon.com/
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Using This Guide

Follow this path to get acquainted with the Embedded Target for Infineon
C166 Microcontrollers and gain hands-on experience with the features most
relevant to your interests:

Read in its entirety, paying particular attention to “Setting Up and
Verifying Your Installation” on page 1-14.

If you are interested in using the device driver blocks supplied with
Embedded Target for Infineon C166 Microcontrollers and in deploying
stand-alone, real-time applications on the C166, read Chapter 2, “Tutorial:
Simple Example Applications for C166 Microcontrollers” Work through the
“Tutorial: Creating a New Application” on page 2-3.

Then, if you are interested in using Embedded Target for Infineon C166
Microcontrollers for integrating automatically generated code with your
own hand-written device driver code, see “Integrating Hand-Coded Device
Drivers with a Simulink Model” on page 3-2. Work though the example
provided in “Tutorial: Using the Example Driver Functions” on page 3-10.

See Chapter 4, “Custom Storage Class for C166 Microcontroller
Bit-Addressable Memory” to find out how to use Embedded Target for
Infineon C166 Microcontrollers to take advantage of C166 bit-addressable
memory. This can significantly reduce code size and increase execution
speed. There are examples provided in “Using the Bitfield Example Model”
on page 4-3.

For in-depth information about the device drivers and other blocks supplied
with Embedded Target for Infineon C166 Microcontrollers, see Chapter

6, “Blocks — Categorical List” It is particularly important to read C166
Resource Configuration, as the C166 Resource Configuration block is
required to use the device driver blocks.

To browse the demos available, select Start > Simulink > Embedded
Target for Infineon C166 Microcontrollers > Demos, or at the
command line enter

demo simulink 'Embedded Target for Infineon C166
Microcontrollers'



Using This Guide

We recommend you work through the tutorials in this User’s Guide with
step-by-step instructions for using and understanding these demos.
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Installing the Embedded Target for Infineon C166
Microcontrollers

Your platform-specific MATLAB Installation Guide provides all of the
information you need to install the Embedded Target for Infineon C166
Microcontrollers.

Prior to installing the Embedded Target for Infineon C166 Microcontrollers,
you must obtain a License File or Personal License Password from The
MathWorks. The License File or Personal License Password identifies the
products you are permitted to install and use.

As the installation process proceeds, it displays a dialog where you can select
which products to install.



Hardware and Sofiware Requirements

Hardware and Software Requirements

Host Platform

The Embedded Target for Infineon C166 Microcontrollers supports only the
PC platform: Windows 2000 and XP only.

You can see the system requirements for MATLAB online at

http://www.mathworks.com/products/system.shtml/Windows

Hardware Requirements

Embedded Target for Infineon C166 Microcontrollers may be used to generate
programs that can run on any development board or Electronic Control Unit
(ECU) that is based on the C166 microcontroller.

The Embedded Target for Infineon C166 Microcontrollers is supplied with
default configurations that have been tested on the following hardware:

¢ Phytec phyCORE-167 ST10F269

¢ Phytec phyCORE-167 C167CS

¢ Phytec kitCON-167 C167CR

¢ Infineon XC167I Starter Kit

You can switch easily between these configurations. For other hardware

variants, you will need to change the default configuration settings. For
details see “Switching Between Hardware Variants” on page 1-11.

This guide assumes that you are working with the Phytec phyCORE-167CS
development board, and documents specific settings and procedures for
use with the Phytec phyCORE-167CS board, in conjunction with specific
cross-development environments.

If you use a different development board, you may need to adapt these
settings and procedures for your development board.

1-9
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Software Requirements

Required and Related MathWorks Products
The Embedded Target for Infineon C166 Microcontrollers requires these

products:

e MATLAB

¢ Simulink

® Real-Time Workshop

¢ Real-Time Workshop Embedded Coder

Simulink Fixed Point is strongly recommended but not essential; it is required
for one of the demos (c166_fuelsys).

For more information about any of these products, see either

¢ The online documentation for that product, if it is installed

® The MathWorks Web site, at
http://www.mathworks.com/products/target c166/

Supported Cross-Development Tools

In addition to the required MathWorks software, a supported
cross-development environment is required. The Embedded Target for
Infineon C166 Microcontrollers currently supports the cross-development
tools listed below:

¢ Tasking C Cross-Compiler and debugger toolchain (version 8.0 r2)

Note The demo version of the Tasking Cross-Compiler is not supported.

® MiniMon freeware download and monitor utility (version 2.2.3)


http://www.mathworks.com/products/target_c166/

Hardware and Sofiware Requirements

Before using the Embedded Target for Infineon C166 Microcontrollers with
the above cross-development tools, please be sure to read and follow the
instructions in “Setting Up and Verifying Your Installation” on page 1-14.

Switching Between Hardware Variants

There are many different members of the C166 microcontroller family, e.g.,
C167CS, ST10, XC167CI. For each of these processors, it is appropriate to
use different compiler switches and link libraries. Even if you are working
with a single processor variant, you may need to build for different memory
configurations, for example, depending on whether the application will run
from RAM or flash memory.

The Embedded Target for Infineon C166 Microcontrollers is supplied with
default configurations that have been tested on the following hardware:

¢ Phytec phyCORE-C167CS (RAM)

¢ Phytec phyCORE-C167CS (flash)

¢ Infineon XC167CI Starter Kit

¢ Phytec phyCORE-ST10F269

¢ Phytec kitCON-C167CR (RAM)

¢ Phytec kitCON-C167CR (flash)

If your hardware variant is not on this list, you will need to change the default

configuration settings. See “Creating a Make Variables Reference File for the
Build Process” on page 1-19.

When switching between target configurations, you should review all of your
Target Preferences and ensure that they are set appropriately for the new
configuration. It is necessary to change the Target Preferences only once and
the new settings will take effect for all subsequent builds.

Additionally, for each model that you build, you must check, and, if necessary,
change the following settings in the C166 Resource Configuration block:

® System_frequency

® External oscillator_frequency

1-11
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To determine the correct value of these parameters, consult your hardware
documentation.

It is possible to make all the required changes programmatically: a
convenience function c166switchconfig is provided for this purpose. This
function can be run by double-clicking the block Switch Target Processor
Variant inside any of the demo models.

Using Prebuilt RTW Libraries

You may need to use this option when switching between hardware variants.
The option to Use prebuilt RTW librariesis found in the C166 Options
(under Real-Time Workshop in the Configuration Parameters dialog) .
Checking this option causes the build process to link against a prebuilt static
library that contains object code for Real-Time Workshop library functions.
If this option is not checked, then all Real-Time Workshop library functions
are recompiled in the model build area; this can be a lengthy process when
the model is built for the first time.

The prebuilt static library matlabroot\rtw\c\lib\win32\rtwlib_c166.1ib
has been built with options selected for C167CS. For other processor variants,
it may be necessary to rebuild this library.

To do this, open a command prompt and run the following commands:

cd matlabroot/toolbox/rtw/targets/c166/1ibs/rtwlib
set C166R0O0T=<path to c166 compiler>

set MATLABROOT=<path to matlab root directory>

set CFLAGS=<required C compiler flags>
matlabroot\rtw\bin\win32\gmake -f makefile clean
matlabroot\rtw\bin\win32\gmake -f makefile

Note that you can obtain appropriate settings for CFLAGS by inspecting the
OPT_CC variable in the MakeVariablesReferenceFile that is specified in the
C166 Target Preferences Setup. See “Creating a Make Variables Reference
File for the Build Process” on page 1-19.

When the make command is complete, the output from the command window
should indicate that all the required Real-Time Workshop library files are
being compiled. This may take a few minutes.



Hardware and Sofiware Requirements

To build the library as originally supplied simply repeat the above steps
except with

set CFLAGS=

i.e. ensure that CFLAGS is undefined. In this case the library will use the
default flags (for C167CS) that are specified in the makefile.

Spaces in Path

Note that if either MATLAB or the compiler are installed in a directory with
spaces in the pathname, you must make sure that the environment variables
C166ROOT and MATLAB_ROOT are specified in 8dot3 format. You can run
the command dir /x from the Windows command prompt to find out the
8dot3 formatted directory names.

1-13
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Setting Up and Verifying Your Installation

The next sections describe how to configure your development environment
(compiler, debugger, etc.) for use with the Embedded Target for Infineon C166
Microcontrollers and verify correct operation. The initial configuration steps
are described in the following sections:

e “Setting Up Your Target Hardware” on page 1-16
® “Setting Target Preferences” on page 1-17

Install the Tasking C Cross-Compiler and CrossView Pro Debugger by
following the instructions provided by Altium Limited.

If the CrossView connection to your target hardware requires a serial
connection, install the MiniMon download utility. By using MiniMon instead
of CrossView to launch your application, the serial connection will be available
for other purposes, if required. If your CrossView connection is via a debug
interface (for example, on XC16x hardware) then it is not necessary to install
MiniMon.

At the time of writing, you can obtain the MiniMon download utility for
monitoring the serial interface from the Infineon Web site at this URL:

http://www.infineon.de/

From here search for “Application notes 16-bit”, then locate
‘minimon_c16x_223 setup 2.zip’.

Be sure to install the 2.2.3 version. Earlier versions do not contain all

the required controller configurations. Once installed you must specify

the location of MiniMon in the BootstrapLoaderExe target preference, as
detailed in “Setting Target Preferences” on page 1-17. Check that MiniMon is
correctly configured for your target, as detailed in the next section.

Verifying MiniMon Settings
You must check that MiniMon has the correct target settings. Start

MiniMon, then click Configure Hardware ( g ) in the toolbar (or select

1-14
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Target > Configuration) and make sure the settings are as in the following
illustration.

This configuration has been verified with both a phyCORE C167CS board
and a Phytec ke167 (C167CR). In general, you should choose configuration
settings that are consistent with the values specified in the Tasking EDE
project that is used to create your Make Variables Reference File.

i, Configure : =
— Initialize reqgister — Controller type
W Syscow  [ooss m [ DPFD I—h |C1E?EFI j Clk: rate |2DDDDDDD Hz

[ BUSCONO h [ DPPI h|
Memormy

[ 4DDRASELY 0006 kw [ DPP2 I h A M

® SFR :00FEOO-00FFFF Add
BUSCOMT [043F h [~ DPPF3 I h ® ESFR :00FO00-00F1FF

b4 InaM :00FS00-00FLFF Edi

r ADDHSELzl h HKEAM :00E000-00E7FF ;

Can O0EFO0O-00EFFF

BUSCON2 [ Riemonve
[~ ADDRSEL3[
BUSCON3 I—h
r ADDHSEL4|—h
Pt I—h Initial command calls

Addr.
[~ Generic 1 I h I h ™ EINIT

i

[~ Genernc 2 I h I h

Clear | i Cancel | 0K
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This guide assumes that you are working with the phyCORE-167CS module
with HD200 development board. This section describes the required
connections and jumper settings for the board. If you are using different
target hardware, you should consult the hardware documentation.

After setting up your board, you must configure target settings associated
with the Embedded Target for Infineon C166 Microcontrollers, as described in
the next section.

Connect the supplied power cable to the board, and use the serial cable to
connect the serial port P1 on the board to the serial port of your PC.

Jumper Settings for the phyCore-167 Development
Board

1 Configure jumpers as detailed in the instructions found in the phyCORE
QuickStart documentation. Note that these settings can be markedly
different from the configuration fresh out of the box.

2 Ifyou are running applications from RAM only, it is useful if the board
starts up in bootloader rather than execution mode. There is one jumper
setting that needs to be changed to achieve this: close pins 1 and 2 on JP10.
This is optional; if you do not close this jumper, then when you download
to the target, you need to keep the Boot switch depressed while pressing
the Reset button.



Setting Target Preferences

Setting Target Preferences

This section describes configuration settings associated with the Embedded
Target for Infineon C166 Microcontrollers. These settings, which persist across
MATLAB sessions and different models, are referred to as target preferences.
Target preferences let you specify the location of your cross-compiler and
other parameters affecting the generation, building, and downloading of code:

1 Start the Target Preferences Setup GUI by selecting
Start > Simulink > Embedded Target for Infineon C166
Microcontrollers > C166 Target Preferences .

-

£2C166 Target Preferences Setup E]@
BootstraplLoaderExe DaspplicationsiMiniMonivinimon223.exe
mMakeVariablesReferenceFile FMATLAR_ROOTutoolbowiwtargetsicl BEtaskino/makeiphyCORE_CIBTCS_wB0ipc167cs.mak
TargetCaompilerPath d:fapplicationsiTaskings. 0ForC166
TargetDehuggerExe d:fapplicationsMaskingd.0F orC1 GEhinkdw B6.exe
TaskingCfgonchip FMATLAE_ROOTHtoolbowmwtargetsicl BEtaskino/cfa/ph1 67 cs_mw cfn
TaskingCfgSimulator d:fapplicationsMasking8.0ForC1 GE/ETCsim 167 05,0y
TaskingRegisterDefs reg1f7cs.h
[ Rezet to Default ] [ Ok ][ Cancel ][ Help ]

2 Edit the settings for your cross-development environment:

® BootstrapLoaderExe specifies the path to your download utility
(MiniMon).

* MakeVariablesReferenceFile specifies a makefile that is used as a
reference for building applications created with Embedded Target for
Infineon C166 Microcontrollers. For further details on creating and
using this file, see “Make Variables Reference File” on page 1-19.
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® TargetCompilerPath specifies the path to your compiler (Tasking).

® TargetDebuggerExe specifies the path to your debugger executable
(CrossView)

® TaskingCfgOnChip specifies the name of a CrossView configuration
file that will be used to start CrossView when the build action is
set to Download _and run_with_debugger. Consult the CrossView
documentation, C166/ST10 CrossView Pro Debugger User’s Guide for
further details.

® TaskingCfgSimulator specifies the name of a CrossView configuration
file that will be used to start CrossView when the build action is set
to Run_with_simulator.

® TaskingRegisterDefs specifies an include file that may be used in the
automatically generated C source code; this file should be located in
the include subdirectory of your Tasking compiler installation. This
target preference allows you to select a register definitions file that is
appropriate for your target hardware and consistent with the settings in
the Make Variables Reference File. The file contains definitions of all the
special function registers, etc., that may be dependent upon your target
hardware. See the Tasking documentation, C166/ST10 C Cross-Compiler
User’s Guide, for further details.

You must check these paths are correct for your machine. You may need to
localize these paths to suit your PC. You can edit a path by clicking on it. The
drive designated in the path must be either an actual hard drive on your PC,
or a mapped drive. Do not use a Universal Naming Convention (UNC).

See the next section, “Creating a Make Variables Reference File for the Build
Process” on page 1-19, for more information on using the configuration files
specified in the target preferences.



Creating a Make Variables Reference File for the Build Process

Creating a Make Variables Reference File for the Build

Process

The default settings provided with Embedded Target for Infineon C166
Microcontrollers allow you to build an application using the C166
microcontroller small memory model and with registers configured
appropriately for a number of evaluation boards, including the Phytec
phyCORE-C167CS and the Phytec KC167.

You can change the default settings by supplying your own configuration
files in the C166 Target Preferences Setup dialog. The following information
explains the purpose of the Make Variables Reference File and how to create a
new one for different memory models or hardware variants.

Make Variables Reference File

The target preference MakeVariablesReferenceFile contains make variables
that are copied and used by the Embedded Target when building a model.
The Make Variables Reference File contains information that is specific to
the C166 hardware variant as well as build settings such as the memory
configuration.

The Make Variables Reference Files provided with Embedded Target for
Infineon C166 Microcontrollers allows you to build an application for selected
evaluation boards such as the Phytec phyCORE-C167CS.

If none of the supplied Make Variables Reference Files are suitable for your
hardware configuration, you must create a new one. The easiest way to do
this is by creating a new project using the Tasking EDE, as described below.

Content of the Make Variables Reference File

The target preference MakeVariablesReferenceFile allows a makefile to be
specified that is used as a reference for obtaining build configuration settings.
The specified makefile is not used directly, rather it is examined and used to
provide the following information:

® OPT_CC is a make variable containing flags used during the compile stage
of the build process.
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OPT_MPP is a make variable containing flags used during the macro
preprocessor stage of the build process.

OPT_LC is a make variable containing flags used during the link/locate
stage of the build process.

start.asmis the startup code that will be copied to the build directory then
compiled and linked with the rest of the application.

Filename.ilo is a file referenced within OPT_LCC that contains extra
instructions for the linker/locator. The content of this file is copied to the
build directory.

Creating a New Make Variables Reference File Using
the Tasking EDE

To create a new Tasking EDE project along with the required Make Variables
Reference File, follow these steps:

2

Create a new folder for the project.
Copy source files for a sample application, e.g.,

matlabroot\toolbox\rtw\targets\c166\tasking\make\phyCORE_C167CS_v80\main.c

to this new directory.
Open the Tasking EDE.

Right-click the root of the project tree and select Add New Project, and
create a new project in the folder created for that purpose.

Click the + icon to scan the source file into the new project.

In the project tree, right-click the new project and set it as the current
project.

Under the menu item Project > Project Options, configure the required
settings for your hardware environment. This should include the following:
a Set the CPU type (and allow EDE to set registers accordingly).

b In the Linker/Locator section, check the option to generate Intel Hex
files.
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¢ In the CrossView Pro/Execution Environment, select the required
evaluation board and confirm that startup registers should be set to
default values for this execution environment; this should ensure that
X-Bus peripherals such as CAN are enabled on hardware where they
are available.

8 Right-click on the project and select Build. Check that the project builds
successfully and that a new Make Variables Reference File with .mak file
extension has been created in the project directory.

9 It is a good idea to test that you can run the application main.c on your
hardware; to do this you should run CrossView and download the compiled
application. You may wish to provide your own sample application instead
of main.c, or make a modification to main.c to test specific features of
your hardware.

10 The new .mak file is now ready for use with Embedded Target for Infineon
C166 Microcontrollers; to use it, you must specify the path to this new file
in your target preferences.

Consult the Tasking documentation C166/ST10 C Cross-Compiler User’s
Guide and C166/ST10 Cross-Assembler, Linker/Locator, Utilities User’s
Guide for further details.

Tasking EDE is the best place to start if you want to configure the startup
code, but you can also try using the Infineon Digital Application Engineer
DAVE. The freeware DAVE is also useful for developing device drivers. See
“Integrating Hand-Coded Device Drivers with a Simulink Model” on page 3-2.
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Supported Blocks and Data Types

Embedded Target for Infineon C166 Microcontrollers supports the same
blocks and data types as Real-Time Workshop Embedded Coder.

Note however

® You should not use IEEE values Inf or NaN in your model: these are not
supported and result in an error.

® Floating point support is implemented in the software; if speed and ROM
usage are of concern, you should select the option for integer code and avoid
the use of floating-point values in your model. This is detailed in step 9 of
“Tutorial: Using the Example Driver Functions” on page 3-10.
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Overview of C166 Configuration Parameters

In the C166 Options (under Real-Time Workshop in the Configuration
Parameters dialog) there are some C166 specific options:

Build action

Download_and_run
This option is described using the C166_serial transmit model
in “Tutorial: Creating a New Application” on page 2-3.

Download_and_run_with_debugger and Run_with_simulator
These options are described in “Starting the Debugger on
Completion of the Build Process” on page 2-12. The CrossView
configuration files for these two options are specified in the Target
Preferences: TaskingCfgOnChip and TaskingCfgSimulator, see
“Setting Target Preferences” on page 1-17.

CrossView startup options file
This field is available when one of the options Run_with_simulator or
Download _and_run_with_debugger is selected for the Build action.
By default, the field is empty; in this case a file containing start-up
options for CrossView is created automatically and is used to run
CrossView at the end of the build process. By specifying a file containing
CrossView start-up options the default file is overridden with your own
start-up options. See the section "Startup Options" in the CrossView
user manual for details on available startup options.

Include input/output driver function hooks
Use this option to integrate your own device driver code. This is
described in “Calling the Device Driver Functions from ¢166_main.c”
on page 3-6.
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Execution profiling options:

Maximum number of concurrent base-rate overruns
Maximum number of concurrent sub-rate overruns
Execution profiling

Number of data points

These are options for task execution profiling. See “Overview of
Execution Profiling” on page 5-2.

Use prebuilt RTW libraries
This option causes the build process to link against a prebuilt static
library that contains object code for Real-Time Workshop library
functions. This can save time when your processor variant can use the
prebuilt library. See “Using Prebuilt RTW Libraries” on page 1-12.
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Tutorial: Simple Example
Applications for C166
Microcontrollers

This section includes the following topics:

Introduction (p. 2-2) An overview of the Embedded Target
for Infineon C166 Microcontrollers
real-time target, other components
required to generate stand-alone
real-time applications, and the
process of deploying generated code
on target hardware.

Tutorial: Creating a New Application A hands-on exercise in building

(p. 2-3) two simple applications from demo
models, including downloading and
executing generated code on a target

board.
Starting the Debugger on This exercise shows you how to
Completion of the Build Process generate code and commence
(p. 2-12) debugging automatically as part of

the build process. Depending on
your debugger, you can debug the
application either on-chip or on a
hardware simulator.

Generating ASAP2 Files (p. 2-16) How to generate ASAP2 files for
your models.
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Introduction

This section describes how to use two example models to generate, download
and run stand-alone real-time applications for the C166 microcontroller. The
components required to generate stand-alone code are

® The Embedded Target for Infineon C166 Microcontrollers real-time target

® The example models provided: c166_serial transmit.mdl and
c166_serial_io.mdl

® The Tasking C Cross-Compiler and Tasking CrossView Pro Debugger for
compiling and downloading generated code to the target hardware

As an alternative to CrossView, you can use the MiniMon utility for
downloading an application to your target hardware.

Using these, you can build the complete applications. You do not need to
hand-write any C code to integrate the generated code into a final application.

The tutorial “Tutorial: Creating a New Application” on page 2-3 uses

two blocks from the Embedded Target for Infineon C166 Microcontrollers
library. For complete information on the Embedded Target for Infineon C166
Microcontrollers library blocks, see Chapter 6, “Blocks — Categorical List”
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Tutorial: Creating a New Application

In this tutorial, you build stand-alone real-time applications from models
incorporating blocks from the Embedded Target for Infineon C166
Microcontrollers library.

In the following sections, you will

¢ Examine two models

® Generate code from the models

® Download and run the code automatically as part of the build process
e Use MiniMon to monitor the code executing on the target

e Use the CrossView Pro Debugger to run a model on the C166 Simulator
or debug on-chip

Before You Begin

We assume that you are already familiar with Simulink and with the
Real-Time Workshop code generation and build process. This tutorial requires
the following specific hardware and software in addition to the Embedded
Target for Infineon C166 Microcontrollers:

¢ Phytec phyCORE-167CS development board, connected via serial port
to your PC

¢ Tasking C Cross-Compiler and CrossView Pro Debugger

® MiniMon download utility

You must make sure the target preferences have been set correctly. See
“Setting Target Preferences” on page 1-17.

Note Make sure the default.ini file in the MiniMon directory is not read
only. This can cause errors.
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E!clﬁﬁ_serial_transmit
File Edit Yiew Simulation Format Tools  Help

Example Model 1: ¢166_serial_transmit

In this tutorial you start with a simple example
model, c166_serial transmit, from the directory
matlabroot/toolbox/rtw/targets/c166/c166demos.

This directory is on the default MATLAB path.

1 Open the model by typing c166_serial transmit at the command line.

This example shows the tutorial model c166_serial transmit at the root
level.

~ol x|

DI@H@I%EIDCH} llinf INormaI VII@IﬁHﬂ@Dﬂ?@

R

ot
C16E6
Fesource

Configuration

uintS Hells iarld' [13 10]]) }—p Dpata 500 Switch Target
Tran=mit Processar Yariant

Text

Serial Transmit

This demo model for the Embedded Target for Infineon C166(R) provides a simple demonstration
using the Serial Transmit block.

YWWhen you generate code for this model, it will automatically launch a download utility program
and load the application onto C166 hardware over a serial connection. When the application
i3 running it sends the text "Hello World" + Carrlage Return + Linefeed over the serial interface.

Ready

[100% | I [FixedstepDiscrete 4

The model contains a C166 Resource Configuration object. When building
a model with driver blocks from the Embedded Target for Infineon

C166 Microcontrollers library, you must always place a C166 Resource
Configuration object into the model (or the subsystem from which you want
to generate code) first.

The purpose of the C166 Resource Configuration object is to provide
information to other blocks in the model. Unlike conventional blocks,
the C166 Resource Configuration object is not connected to other blocks
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via input or output ports. Instead, driver blocks (such as the ASCO
Serial Transmit block in the example model) query the C166 Resource
Configuration object for required information.

For example, a driver block may need to find the system clock speed
that is configured in the C166 Resource Configuration object. The C166
microcontroller has a number of clocked subsystems; to generate correct
code, driver blocks need to know the speeds at which these clock busses
will run.

The C166 Resource Configuration window lets you examine and edit the
C166 Resource Configuration settings.

2 To open the C166 Resource Configuration window, double-click the C166
Resource Configuration icon. The picture following shows the C166
Resource Configuration window for the c166_serial transmit model.

<) 166 Resource Configuration =10 x|
Active Configurations |< Syatetn Configuration |
e External oscillator frequency e
1 BGdriversidsynchronousiSynchronous Serial Interface Free_running_timer :I MNone
Systermn_frequency 20000000.0
Systermn_timer :|T3, reload from T2
Timer_interrupt_level :l 7
Timer_interrupt_level_group :l i
J | 2]
Status |
0K : —
QK | Apply | Help |

In this tutorial, use the default C166 Resource Configuration settings.

Note If hardware is running at a system frequency other than 20 MHz,
you must change this parameter appropriately.

Otherwise, observe, but do not change, the parameters in the C166
Resource Configuration window. By default, the c166drivers
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configuration is selected. This shows parameters for the C166
microcontroller CPU in the System Configuration pane on the right.

3 View the settings for the serial driver block by clicking the
c166drivers/Asynchronous/Synchronous Serial Interface option
in the Active Configurations pane. These settings are shown in the

following illustration.

1ol x|
Active Caonfigurations 1 RTW Configuration
c1BEdrivers — Bit_rate_achieved 8615.385
] Mo | — Bit_rate_ideal 9R00.0

Kl

— Loopback_rmode_enahble

— hade_cantral

— Parity_selection

— Receive_buffer_size

— Receive_interrupt_level

— Receive_interrupt_level_group
— S0CON

— Stop_hits

— Transrmit_huffer_size

— Transmit_interrupt_level

— Transmit_interrupt_level_group

j Standard transmit'receive mode
:l 8-hit data, asynchronous
R
32
~|14
|1
0x8011
j Cne stop hit
34
|14
|0

Status

0K :

Ok | Apply | Help

2-6

The settings appear in the RTW Configuration pane on the right. Do not
edit any of these parameters for this tutorial. To learn more about the C166
Resource Configuration object, see C166 Resource Configuration.

4 Close the C166 Resource Configuration window before proceeding.

Generating and Downloading Code

To generate code for the model:
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1 Select Simulation > Configuration Parameters.
The Configuration Parameters dialog opens.

2 Select Real-Time Workshop in the tree, as shown below.

E Configuration Parameters: c166_serial_transmit/Configuration e |

—Target selection

- Sulver RTW sustern target file: |c166.He Browse... |
- D1ata Impaort/E xport

Select:

... Optimization Drescription;
& D!agnoshcs . —Documentation
i Sample Time

Drata Integrity ™ Generate HTML report

Corwversian ™ Include hyperlinks to mode!
Connectivity
Compatibility
- hodel Referencing —Build process
- Hardware Implementation
- Model Referencing
= im
Comments
Symbols
Cusztomn Code

Debug
Interface [ lgnore custom storage classes

[™ | Launch repart after code generation completes

TLC options: I

td ake command: Imake_ltw

Template makefile; |c1 EE. trnf

—Custom ztorage class

Templates

- Data Placement ™ Generate code only Build |
‘- C166 Optionz (1]

kK I LCancel | Help | Apply |

3 Select C166 Options (1) (under Real-Time Workshop in the tree).
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E Configuration Parameters: c166_serial_transmit,/Configuration . 21x]
Select: |
S olver Build action: | Download_and_run =l
- Datal t/Export : S
i mper L Hpor Crozstiew startup options file:
- Optimization
[=- Diagnostics ™ Include inputfoutput driver function hooks
i Sample T"T!E Maximum number of concurrent base-ate overuns: |5
- Data Integrity
- Corvversion b asimurm number of concurent sub-rate ovenunz I‘I
Cnnnec:.h\f!ty [ Execution profiing
i Compatibility
o Model Referencing Number of data points: |500
~ Hardware Implementation v Use prebuilt RTW lbraries

- Model Referencing
=] Real-Time Waorkshop
o Comments

- Symbols

- Custorm Code
- Debug

- |nterface

- Templatez

ar LCancel | Help | Apply

Make sure that the Build action is Download_and _run. When you
generate code for this model, it automatically starts a download utility
program and loads the application onto the C166 microcontroller hardware
over a serial connection. The code then begins execution on the target.

4 Return to the Real-Time Workshop options (click Real-Time Workshop in
the tree) and click Build.

Note that you could have gone straight to building the model by selecting
Tools > Real-Time Workshop > Build Model or using the shortcut
Ctrl+B.
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Watch the progress messages in the command window as code is generated.
When MiniMon is started, a dialog appears asking you to reset your
hardware.

5 Press the Reset button on your phyCORE-167CS board or cycle the power,
and then click OK.

You can see progress messages in the MiniMon window as it connects and
then downloads to the target. MiniMon then disappears and the code
begins executing on the target.

Verifying Code Execution on the Target

1 Start MiniMon (select Start > Programs > MiniMon > MiniMon in
Windows, or navigate to MiniMon.exe and double-click).

2 Watch the model output in the MiniMon window. When the application
is running, it sends the text "Hello World" plus a carriage return and a
linefeed over the serial interface.

Example 2: ¢166_serial_io

This example model demonstrates how to use both serial transmit and receive
blocks for the C166 microcontroller. You could use these blocks in this way
with your own Simulink models.

1 Open the model by typing c166_serial io at the command line.
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E!clﬁﬁ_serial_io =101 x]

File Edit “iew Simulation Format Tools Help %

Ned@&| $BBR|S 2] » llinf INormaI 'I@ﬁ”ﬁ@ﬁ@

Convert to ASCI

ASCII String |——
Data Data i) | Hurmbs
- ASCO String iifidth
Receive Bytes received Restart I
Hum bytes to read Serial Receive Generate
Fibonace
Sequence NOT . y S
2rge - Data
i > ASCO.
Transmit
! Serial Transmit
; & h 4
Switch Target - 4 n
P ! 2 O ASCI Text |—
rocessorvariant T (. y
erge
CAGE Text Width -
Resource
Configuration Header Texd

This demo model far the Embedded Target for Infineon C166 provides a simple demonstration
using the Serial Transmit and Serial Recelve blocks

WWhen you generate code for this model, it will automatically launch a download utility prograrm
and load the application onto C166 hardware over a seral connection. When the application is
running, it generates a sequence of 16 bit numbers, converts therm to ASCI characters and
transmits therm over the serial interface. You can monitor the serial interface with the Windows
application HyperTerminal or with the the Minion download utility

It you enter the character 'r' in the Minion command ling field the application will restart at the
beginning of the sequence

Ready 100%: FixedStepDiscrete
4

2 Press Ctrl+B or select Tools > Real-Time Workshop > Build Model.

Watch the progress messages as code is generated from the model and
MiniMon is automatically started to download the code to the target over
the serial connection. The MiniMon dialog appears asking you to reset
your hardware.

3 Press the Reset button on your phyCORE-167CS board or cycle the power,
and then click OK.

You can see progress messages in the MiniMon window as it connects and
then downloads to the target. MiniMon then disappears and the code
begins executing on the target.

You can restart MiniMon to monitor the serial interface.
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Verifying Code Execution on the Target

1 Start MiniMon (select Start > Programs > MiniMon > MiniMon in
Windows, or navigate to MiniMon.exe and double-click).

2 Watch the model output in the MiniMon window. When the application
is running, it generates a sequence of 16—bit numbers, converts them to
ASCII characters, and transmits them over the serial interface.

3 If you enter the character r in the MiniMon command line field, the
application restarts at the beginning of the sequence. Examine the model
to see how this works: the Serial Receive block passes the restart command
through to the Generate Fibonacci Sequence subsystem. This subsystem
checks for the restart command.
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Starting the Debugger on Completion of the Build Process

As an alternative to downloading with MiniMon at the end of the build
process, you can start your debugger. Depending on the features provided by
your debugger, you can debug the application either on-chip or on a hardware
simulator.

For this example, you use another demo model, c166_user_io.mdl. This
model is designed to show you how to integrate your own hand-coded device
drivers with automatically generated code using Embedded Target for
Infineon C166 Microcontrollers. This model is covered in detail in Chapter
3, “Integrating Your Own Device Drivers”. You use it as an example here
because you will typically need to use the debugger in cases where you are
integrating your own code.

Also, note that running the debugger on-chip over the serial interface conflicts
with the serial transmit and receive blocks. The c166_user_io model does not
use serial blocks, so this avoids serial conflicts for this example. If you need to
debug an application that includes the serial transmit and receive blocks, you
must run the debugger using a hardware simulator; alternatively, it may be
possible to run your debugger on-chip without using the serial interface, for
example, if debugging over CAN or JTAG is available.

1 Open the model c166_user_io.mdl.
2 Select Simulation > Configuration Parameters.

3 Select C166 Options (1) (under Real-Time Workshop in the tree).
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=] configuration Parameters: c166_serial_transmit/Configuration . 2=l
Select: |
- Sobeer Build action: | Download_and_run_with_debugger =l
Dat§ |.I'I'||3.D[L-"E:-:|30[t Crozg\iew startup options file:
- O ptimization
[=- Diagnostics I Include input/output driver function haoks
- Sample T"T!e M axirmurn number of concurent base-rate overmins: |5
- Data Inkegrity
- Conversion Marimurn number of concurrent sub-rate averng: |‘|
COnneC_ll\."!l}' I Execution prafiing
... Carnpatibility
. Model Rieferencing Humber of data points: {500
- Hardware Implementation IV Use prebuilt RT'w libraries
- b ndel Referencing

[=1- Real-Time Warkshop
- Comments

- Symbols

- Custom Code

- Debug

- Interface

- Templates
Placement

ok I LCancel | Help | Apply

4 Select the Build action Run_with_simulator or
Download_and_run_with_debugger.

5 Before generating code, check that your target preferences related to the
debugger are correctly configured. See “Setting Target Preferences” on
page 1-17.

6 Click OK.

7 Right-click the controller subsystem and select Real-Time
Workshop > Build Subsystem.

8 Click Build in the next dialog.

Watch the progress messages in the command window as code is generated.
At the end of the build process, your debugger launches automatically with
the application ready to run. You may now debug the application.
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Note If your model contains a serial transmit or receive block, it is not
possible to perform on-chip debugging over the same serial interface.
Attempting to use the debugger in this case causes an error.

See also the next section, “Fixed-Point Example Model: ¢166_fuelsys” on
page 2-14, for an example demo that starts the debugger in simulation mode
rather than on-chip.

Fixed-Point Example Model: ¢166_fuelsys

The c166_fuelsys model is derived from the demo fuelsys.mdl. The floating
point control algorithm from the original model has been converted to fixed
point to allow efficient code generation for the Infineon C166 microcontroller.
This demo starts the debugger in simulation mode rather than on-chip.

Note This demo requires Simulink Fixed Point.

The complete model includes a plant simulation as well as a fixed-point
implementation of the control algorithm. When you generate code for this
example, be sure to generate code for the control algorithm subsystem only:

1 Open the model c166_fuelsys.mdl.
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E]cl 66_fuelsys

~lalx]

File Edit ‘iew Simulation Format Tools Help

Fault-Tolerant Fuel Control System

throttle zenzor I L
0 engine speed oZ_out Read help
= throttle for this model
throttle
commandl_iE‘._G
engine

¥

) L—pm{throttle angle RSP — )
Nominal wpacd 4’%—» - Switch Target
S;;;d B+ engine speed F Processor Yariant
ETE o
o0 o o lﬁ;‘:‘d sensor fuel rate Pl oubl =1 fuel airffuel ratio
High —’_D\o—p wlEn To build the: ‘fuel rate
Speed Ll fisced engine '
o controller' subsystem,
(radfSec) P point to 922 right-click on that block
EGO sensor double dynamics -
and select Real-Timme
R, el htap Workshop then Build
>
4>E| Subsystem ...
L =
MAF sensor double fuel rate hetered Fuel airffuel
to fixed paint controller mixture ratio
Ready |100% I jode4s S

2 Right-click the fuel rate controller block.

3 From the pop-up menu, select Real Time Workshop > Build Subsystem.

4 On the following dialog, click Build.

When code generation is complete, the Code Generation Report appears in
your Help browser. Here you can review the RAM and ROM requirements

of the model. To do this, left-click the link Code profile report in the left
list. For comparison, you may want to build the original floating-point version
of the fuelsys control algorithm: you should find that using the fixed-point
implementation results in a considerable reduction in both RAM and ROM.
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Generating ASAP2 Files

ASAP2 is a data definition standard by the Association for Standardization of
Automation and Measuring Systems (ASAM). ASAP2 is a standard description
for data measurement, calibration, and diagnostic systems. The Embedded
Target for Infineon C166 Microcontrollers lets you export an ASAP2 file
containing information about your model during the code generation process.
See also “Compatibility with Calibration Packages” on page 7-26.

Before you begin generating ASAP2 files with the Embedded Target for
Infineon C166 Microcontrollers, you should read the “Generating ASAP2
Files” section of the Real-Time Workshop documentation. That section
describes how to define the signal and parameter information required by
the ASAP?2 file generation process.

Select the ASAP2 option before the build process as follows:
1 Select Simulation > Configuration Parameters.
The Configuration Parameters dialog appears.
2 Select Interface (under Real-Time Workshop) in the tree.

3 Select the ASAP2 option from the Interface drop-down menu, in the Data
exchange frame, as shown following.
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=] configuration Parameters: c166_serial_transmit/Configuration : d |

Select:

- Solver

- Data Impaort/E sport

- O phimization

[ Diagnostics

- Sample Time

- D ata Integrity

- Cornversion

... Connectivity

.. Compatibility

- bodel Referencing
-Hardware [mplementation

- M odel Referencing
-Real-Time wWaorkshop

- Comments

- Sypmbolz

- Custom Code

- Data Placement
- C166 Options (1)

— Software enviranment

Target floating point math environment: I AMSI-C ;I
Ltility function generation I Auta ;I
Support: | floating-point numbers [ comples numbers ™ nonfinite numbers

v abzclute time ¥ continuous time ¥ norinlined s-functions

—Code interface
™ Temminate function required ¥ Single outputéupdate function [~ GRT compatible call interface
I Generate reusable code

I Suppress emor statug in realtime model data shucture

—Walidation

™ Create Simulink [S-Function) block [~ MAT-file loaging

—Data exchange

Interface: | ASAP2 LI

0K I Lancel Help Apply

4 Click Apply.

The build process creates an ASAM-compliant ASAP2 data definition file for
the generated C code.

Note that standard Real-Time Workshop ASAP2 file generation does not
include the memory address attributes in the generated file. Instead, it leaves
a placeholder that must be replaced with the actual address by postprocessing
the generated file.

Embedded Target for Infineon C166 Microcontrollers performs this
postprocessing for you. To do this, it first extracts the memory address
information from the map file generated during the link process. Secondly, it
replaces the placeholders in the ASAP2 file with the actual memory addresses.
This postprocessing is performed automatically and requires no additional
input from you.
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For an example of a model that is configured to generate an ASAP2 file, see
c166_ccp.mdl.
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Integrating Your Own
Device Drivers

This section includes the following topics:

Integrating Hand-Coded Device
Drivers with a Simulink Model
(p. 3-2)

Preparing Input and Output Signals
to the Device Driver Functions
(p. 3-3)

Calling the Device Driver Functions
from ¢166_main.c (p. 3-6)

Adding the I/O Driver Source to the
List of Files to Build (p. 3-8)

Tutorial: Using the Example Driver
Functions (p. 3-10)

Overview of the steps required to
integrate your device drivers with a
Simulink model.

How to structure your model’s
inputs and outputs using the demo
c166_user_io.mdl as an example.

Real-Time Workshop settings to
call your hand-coded device driver
functions.

How to customize the Real-Time
Workshop make command to
integrate your device driver code.

A tutorial to show you the example
driver functions and how they are
integrated with Embedded Target for
Infineon C166 Microcontrollers. This
includes generating, downloading
and running code from the controller
subsystem of the c166_user_io.mdl
demo model.

For a guide to creating device drivers, see "Developing Device Drivers for
Embedded Targets" in the Developing Embedded Targets for Real-Time
Workshop Embedded Coder documentation.
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Integrating Hand-Coded Device Drivers with a Simulink

Model

Embedded Target for Infineon C166 Microcontrollers has a limited set of I/O
device driver blocks. This means that, for most applications, it is necessary to
write some device driver code by hand.

This approach requires the following steps:

1 Identify the model inputs/outputs that must be read from/written to device
driver functions.

2 Set the data type and storage class for each input or output signal so that it
is compatible with your device driver code.

3 Use the hooks provided in the automatically generated c166_main.c to call
your device driver initialization, input, and output functions.

4 Add your device driver source code to the list of files that must be included
in the build process.

Each of these steps is described in the following sections. An example model
is provided: c166_user_io.mdl.

An alternative approach is to create Simulink I/O blocks that automatically
generate the device driver code. This approach may be worth considering if
you need to reconfigure the I/O behavior frequently. If you want to take this
alternative approach, you should consult the documentation on S-functions
and TLC. See the section Developing Device Drivers for Embedded Targets
in the document Developing Embedded Targets for Real-Time Workshop
Embedded Coder.

A useful tool for creating C166 device drivers is the freeware Digital
Application Engineer DAVE from Infineon. You can find this at the following
URL:

http://www.infineon.de/dave

Using this package along with the hardware User’s Manual greatly eases the
task of developing your own device driver code.


http://www.infineon.de/dave%0D

Preparing Input and Output Signals to the Device Driver Functions

Preparing Input and Output Signals to the Device Driver

Functions

Structure your model similarly to c166_user_io.mdl. Place the control
algorithm that will be targeted onto the C166 microcontroller hardware in

a separate subsystem. Before generating code, you can run this model in
closed-loop simulation; this allows you to validate the correct behavior of your
control algorithm before running it in real time.

When structuring your model in this way, you should make sure that all the
input and output signals to the control algorithm are channeled through
top-level input or output ports in the control algorithm subsystem.

By default, when you generate code for the control algorithm subsystem,
Real-Time Workshop chooses variable names and data structures for each of
the top-level input and output signals. However, in this case, you must ensure
that the variables are global, and that their names and data structures match
those that are required by the hand-written device driver functions.

The example model c166_user_io illustrates some alternative ways to
achieve this. The simplest method is to

1 Select one of the signals in your model connected to a top-level output
port in the control algorithm subsystem. As an example, open the demo
c166_user_io.mdl.

2 Open the controller subsystem.
3 Click the output_PWMO signal.
4 Select the menu item Edit > Signal Properties.

The Signal Properties dialog appears, as in the example following.
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E Signal Properties: output_PWMO ﬂ

Signal name: |output_P/t0

[ Signal name must resolve to Simulink signal object

Documentation I
RT'w storage class: I ExportedGlobal LI
RT'w storage type qualifier: I

Logging and accessibility | F|

Ok LCancel | Help | Apply |

5 Enter the required variable name for your signal in the Signal name edit
box. This must match the variable name required by your hand written
device driver functions.

6 Click the Real-Time Workshop tab and select ExportedGlobal from the
RTW storage class drop-down menu.

When you generate code for this model, Real-Time Workshop uses the variable
name that you have specified and creates an extern declaration in the model
header file. By using a #include directive to include this model header file in
your device driver source code, it is possible for the device driver functions

to read or write this variable that is defined in the Real-Time Workshop
generated code.

A more sophisticated approach is to use custom storage classes. By using
custom storage classes, you can collect a number of input or output variables
together into a C struct, resulting in more readable code. The LED output
signal in the c166_user_io.mdl uses a custom storage class, which uses a
single bit in a bitfield variable. See “Tutorial: Using the Example Driver
Functions” on page 3-10 for details about the different ways the model
variables are defined and referenced to interface the hand-coded driver
functions and the automatically generated code.



Preparing Input and Output Signals to the Device Driver Functions

By defining your own custom storage classes, you have complete control over
the data structures that are used for any signal in the model. See the custom
storage class documentation in the Real-Time Workshop Embedded Coder
documentation for more details.
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Calling the Device Driver Functions from ¢166_main.c

You should check the option to include I/O driver function hooks. When
Real-Time Workshop generates code for this model, it includes some extra
calls to user-supplied I/O device driver functions:

1 Select Simulation > Configuration Parameters.

The Configuration Parameters dialog appears.

2 Select C166 Options (1), under Real-Time Workshop in the tree, as
shown in the example below.

[=]configuration Parameters: c166_user_io/Configuration ed |
Select;
- Solver Build action: | Download_and_n =l
- [ata | 1/E sport ; : :
a § .mp.or #pat Crozziew startup options file:
- [ phimization
= Diagnostics IV Include inputfoutput driver function hooks
- Sample T|rn§ M asimurn number of concurrent baze-rate averruns: |5
- [ ata Inteqrity
- Cokversion b asirurn number of concurent sub-rate overruns: |1
---Eonnec_tl\_f!ly [ Execution profiing
i~ Compatibility
‘.. Model Referencing Murnber of data points: |500
- Hardware Implemenlatlnn ¥ Use prebuilt RTW libraries
- Model Referencing
= Real-Time “Wark shop
i Comments
- Symbiols
- Cugtom Code
- Debug
- [terface
- Templates
(] I LCancel Help Apply

3 Select the check box option for including I/O driver function hooks.




Calling the Device Driver Functions from c166_main.c

These functions are

user_io initialize — called following model initialization

base rate model inputs — read model inputs, called at the base
sample rate

base rate model outputs — write model outputs, called at the base
sample rate

sub_rate i model inputs — read model inputs, called at the start of
sub-rate 1, where i=1, 2, ....

sub_rate i model outputs — write model outputs, called at the start
of sub-rate i, where i=1, 2, ....

If you are using the automatically generated c166_main.c, then these
function names are fixed.

For an example implementation of these functions, open the model

c166_user_io and follow the link to open the I/O driver source files. These
are described in “Tutorial: Using the Example Driver Functions” on page 3-10.
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Adding the

E! Configuration Parameters:

Select:

- Solhver

- Data Import/Esport
- O ptimization

[ Diagnostics

- Model Referencing
- Hardware [mplementation
- Model Referencing
-

ata Placemsnt
L. C166 Options [1)

1/O Driver Source to the List of Files to Build

You must tell the Real-Time Workshop build process to compile and link the
I/O driver source files that you have written. To do this, you must add some
extra arguments to the make rtw command in the Real-Time Workshop tab
of the Simulation Parameters dialog:

1 Select Real-Time Workshop in the tree.

c1b66_user_io/Configuration ] ilil

— T arget selection

RTw spztem target file; |c1EE.Ho Browse... |

Description:

—Documentation
[~ Generate HTML report
I™ Include hyperlinks to model

[T Launch repert after cade gereration completes

—Build process

TLC optioris: |

Make command: Imake_rtw_usel

Template makefile: |c1 6. tmf

—Custom storage class

™ lgnore custom storage classes

[~ Generate code only Build |

0K I LCancel Help Apply

2 Alter the Make command in the edit box.
You must specify the names of the additional source files, e.g.,

make rtw USER_SRCS = "fileil.c file2.c" USER_INCLUDES =
"-Iincludedirtl -Iincludedir2"



Adding the /O Driver Source fo the List of Files to Build

If you have several files to add, it may be convenient to put the command
inside a new file, as in the example file:

make rtw_user.m

and replace the make_rtw command with make_rtw_user.

You are now ready to build your model and run it in real time.

You can examine an example of this custom make command in the example
model c166_user_io. See the instructions in “Tutorial: Using the Example

Driver Functions” on page 3-10. Step 8 shows you how to specify the location
of your own hand-coded drivers.

3-9



3 Integrating Your Own Device Drivers

3-10

Tutorial: Using the Example Driver Functions

The example model c166_user_io demonstrates how to integrate user-defined
device driver code. In this tutorial, you generate code from the controller
subsystem, which automatically downloads and runs on the target.

The model c166_user_io illustrates three alternative methods for using
global variables to interface the hand-written driver functions with the
Real-Time Workshop automatically generated code. The three different
methods are illustrated by these signals:

® input_adcO
® output_PWMO
® output_led D3

For input_adcO0, the variable is defined in the hand code and referenced in
the Real-Time Workshop code.

For output_PWMO, the variable is defined in the Real-Time Workshop code and
referenced in the hand code.

For output_led D3, a more sophisticated approach is used, involving custom
storage classes. In this case, the variable is again defined in the Real-Time
Workshop code and referenced by the hand code; the difference is that the
variable is defined and referenced as a bitfield using C166 microcontroller
bit-addressable memory:

1 Open the model c166_user_io.mdl.



Tutorial: Using the Example Driver Functions

=0l ]

E!clﬁﬁ_user_in *
File Edit Wiew Simulakion Format  Tools  Help

driwe_signal g 2
= meazured_position Open Uio drfver
source files
LED_O3
= position demand LED_DZ
B - Open custom storage
contraller output_dig1 class data file
m coutput Pt > Crpen help for
position demand mteg’atinghandcnde
[ ]
> Switch Target
Scope Processar Yariant
measured_position drive_signal To build the ‘controller*
subsystem, right-click
plant model on that block and select
Real-Time Workshop
then Build Subsystem ...
Ready [100% [ [ |ode4s o

2 Open the controller subsystem by double-clicking and select the signal
input_adcO.
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E!l:1EE_user_iu,.n"l:untruller i S [=] S
File Edit Wiew Simulation Format Tools Help
O @EE&| &R0z r s [Noml = e F

position demand

=2

uintBE12)

drive_signal_offset

output_ Pk

measurad_position

Clodk generator

Clock generatart

1
(3 input_ada0

lowzk

output_led_D3
lock

autpur_ig?

output_dig1

> )

drive_signal

C166
Resource
Configuration

Ready [100% | | |ode4s 4
3 Select the menu item Edit > Signal Properties.

The Signal Properties dialog appears.

=) signal Properties: input_adcd X|

Signal name: Iinput_adcl:l

[ Signal name must resolve to Simulink signal object

Documentation I

Shaow propagated zignals I off vI

RT'w storage class: I ImportedE sterm

#

RT'w storage type qualifier: I

LCancel

Help

Apply
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Click the Real-Time Workshop tab and observe that the RTW storage

class is ImportedExtern. When you generate code for this model,
Real-Time Workshop uses the specified variable name input_adcO and

creates an extern declaration in the model header file. Since the Real-Time
Workshop storage class is ImportedExtern, this variable must be defined
in the hand-written driver code. When you open the file user_io.c in the
next step, you will find the line uint16_T input_adcO that provides this

definition.

4 In the top level model, double-click the link Open the i/o driver source

files.

Two source files open in the MATLAB editor, user_io.h and user_io.c.

File Edit Wew Text Debug Breakpoints ‘Web ‘Window Help

DS | 2| | S #F

1 7=
2 * File: user_io.h
c
4 # hhatract:
& * Example file showing how to integrate hand-code input/output driver
4] * functions with Embedded Target for Infineon Cl66.
7 *
a8 * fRevision: 1.1 %
9 % gDate: 2002710703 09:45:27 §
10 -
11 w4
12
13| #include "twwtypes.h”
14
18] /*==================================================%
16 # Declare wariahles that are imported by the model
17 fzz==z====z=====z=====s=====z=====s=====s===s=z=====z%/
18] extern uintlé T input_adco;
19
20| f¥=====================%
1

Eﬁ|@@@@@|8taw:lﬂase vlil

il—'l user_io.h | User_io.c |

5 Click the user_io.h tab, as shown above. Here you can see extern
uint16_T input_adcO under the heading Declare variables that
are imported by the model. Also look at the #include directive in
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=] Configuration Parameters: c166_user_io, Configuration . e

Select:

- Solver

- D ata [mport/E spart
. 0 plimization

[=]- Diagnostics

o Sample Time

‘- hodel Referencing
- Hardware |mplementation
- b ndel R eferencing
=] i op

ata Placement
L. C16E Options [1]

user_io.c. The extern declaration and incorporating the header file into
the build makes it possible for the device driver functions to read or write
this variable that is defined in the Real-Time Workshop generated code.

6 In the controller subsystem, select Simulation > Configuration
Parameters. The Configuration Parameters dialog opens.

7 Select Real-Time Workshop in the tree, and in the Build process pane
look at the Make command:

make rtw_user

— T arget gelection

Fi T zystemn target file: IC‘IBB.tIc Browsze. .. |

D escription:

—Documentation
[~ Generate HTML report
= Include hyperlipks to radel

™ Launch report after code gereration completes

—Build proce:
TLC options: I

Make command: Imake_rtw_user

Template makefile: Ic‘l EE.trof

—Cuztom storage cla

[ lgnore custom storage classes

[ Generate code only Build |

oK I Cancel | Help | Apply |

This command instructs Real-Time Workshop to compile and link the
hand-coded I/O driver source files specified in the make file in the build
process.
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8 Look at the make file to see how these are specified. At the command line
type:

edit make_rtw_user

B} p:\LatestMATLAB' toolbox' rbw' targets',c 1664 c166demos’,make rEw User.m = | [m] | ﬂ

File Edit Wiew Text Debug Breakpoints wWeb window Help

DEH| 2R (S| #F| 80 BEERE| s« = x

1 |°s MAFE RTW_USER make command including additional sources =
2
3 % Copyright 2002 The MathWorks, Inc.
4 5 (Rewision: 1.1 §
] x ghate: ZO0Z/L0/00 10:34:26 5
B
7= uger_srcs_arg = [ 'UIERE_SRC3="' matlabroot ...
a 'frtoclbox/rowstargets/olen/cletdencs sare/user_io.e™ ' ]
9 - uzer_includes_arg = [ 'USEE_INCLUDE3="-I' matlabroot ...
10 'ftoolbox/rtwitargets/oled/clegdenos fsEc™ ' ]
11
12|=| make rtwiuser_srcs_arg, user_includes arg):
13
=
J| [
|script [Ln1 Cal 1

Observe the lines specifying the path to the hand-coded I/O driver source
files to be compiled and linked. This is where you would specify the location
of your own hand-coded drivers. For this tutorial, do not make changes in
the make file. Close the editor and return to the Configuration Parameters
dialog.

9 Select C166 Options (1) (under Real-Time Workshop in the tree).
Observe the selected option Include input/output driver function
hooks.
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E Configuration Parameters: c166_user_io/Configuration 21x]
Select:
S olver Build action: | Download_and_run =l
- Data | t/E xport ; : ;
i mper L Hpor Crozs¥iew startup options file:
- Optimization
[=- Diagnostics V¥ Include input/output driver function hooks
- Sample T"T!E Maximum number of concurment base-rate overuns: |5
Drata Inkegrity
Corveersion b asimurm number of concument sub-rate ovenuns I‘I
Cnnnec:.h\f!ty [ Execution profiing
Carnpatibility
.. Model Referancing Nurber of data paints: (500
- Hardware Implementat|on ¥ Use prebuilt RTW libraries
- Model Referencing
=] Real-Time Waorkshop
e Comments
Symbols
Cusztomn Code
Diebug
Interface
Templates
Data Placement
Ok LCancel | Help | Apply

This instructs Real-Time Workshop to include extra calls to the
user-supplied I/O device driver functions when code is generated for this
model.

10 Select Interface in the tree. Observe the option Floating-point

numbers is not selected.

If your model does not use floating point, you should make sure this option
is not checked to use integer code only. Using only integer code results in
smaller code size and faster real-time execution. It also speeds up the build
process because libraries that are used only by floating-point applications
are not included.




Tutorial: Using the Example Driver Functions

Explore the user_io.c file. This example file is intended to show you some
hand-coded input/output driver functions and how they can be integrated
with Embedded Target for Infineon C166 Microcontrollers.

You can see sections for initializing these input/output drivers: ADC,
digital I/O, and Pulse Width Modulation (PWM).

11 Close the Signal Properties dialog and Configuration Parameters dialog
if they are still open.

Prior to generating code, you can run the model in closed-loop simulation;

just click Start Simulation ( > ) in the toolbar. You can open the

Scope block to see the model output. If you use this model as a basis

for integrating your own device driver code, this closed-loop simulation
allows you to validate the correct behavior of your control algorithm before
running it in real time.

12 Generate code by right-clicking the controller subsystem and selecting
Real-Time Workshop > Build Subsystem.

13 Click Build in the Build code for Subsystem: Controller dialog that
appears. Watch the messages as the process proceeds; code is generated,
downloads, and runs on the target.

If you are using a Phytec phyCORE module with HD200 development
board, the digital output is connected to the LED D3. You can see successful
execution of the code when the LED blinks.

3-17



3 Integrating Your Own Device Drivers

3-18



Custom Storage Class
for C166 Microcontroller
Bit-Addressable Memory

This section contains the following topics:

Specifying C166 Microcontroller
Bit-Addressable Memory (p. 4-2)

Using the Bitfield Example Model
(p. 4-3)

How to use Embedded Target for
Infineon C166 Microcontrollers
to take advantage of C166
microcontroller bit-addressable
memory. This can significantly
reduce code size and increase
execution speed.

This is a step-by-step guide

to the example model
c166_bitfields.mdl. This model is
configured to launch the debugger
at the end of the build. Included

is a comparison with another
custom storage class variable in
c166_user_io.mdl
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Specifying C166 Microcontroller Bit-Addressable Memory

Embedded Target for Infineon C166 Microcontrollers allows you to take
advantage of C166 microcontroller bit-addressable memory. The example
model ¢c166_bitfields.mdl demonstrates this. By using bit-addressable
memory, the compiler is able to use special assembler instructions that
significantly reduce code size and increase execution speed.

At the Simulink level, this is done by using the custom storage class
SimulinkC166.Signal. To specify that a signal in the model should use
bit-addressable memory, you must perform the following steps:

1 Ensure that the signal has the Simulink data type 'boolean’.

2 Attach a label to the signal, either by using Edit > Signal Properties or
by double-clicking the signal and typing in the name directly; this label will
be used as the bitfield variable name in the generated code.

3 Create a new Simulink data object of type SimulinkC166.Signal with
the same name as the signal label. See the file c166bitfielddata.m for
an example.

4 Select View > Model Explorer and click the base workspace to inspect all
the Simulink data objects that are available to the model.

5 Build the model.

The example model c166_bitfields.mdl is configured to start the debugger
at the end of the build. To try this, see the next section “Using the Bitfield
Example Model” on page 4-3.

One of the signals in the demo model c166_user_io.mdl also uses the
custom storage class SimulinkC166.Signal to specify that the signal uses
bit-addressable memory. You can compare this with the c166_bitfields
example; it is included in the steps in “Using the Bitfield Example Model”
on page 4-3.



Using the Bitfield Example Model

Using the Bitfield Example Model

You can use the example model c166_bitfields.mdl to see the automatic
debugger start at the end of the build.

Follow these steps:

1 Open c166_bitfields.mdl.

[S)c166_bitfields i =] 3

File Edit Yiew Simulation Format Tools  Help

Fead documentation

tempLimit for C166 hit-
addressable memaory

£=

: T
Eme AND 1) Read documentation
v for custam
tempCheckEnabled |:_| . storage classes
| p n tempAamm Latched r@
Latch Temperature
Alarm Inspect data objects

(:rpm

=

Generate code and

Tl T

AND :@ launch debugger
| rpmCheckEnabled E“_I S
rpm eckEnable -
P n e »d Open setup file
Latch Speed
Alarm Switch Target

Processor Variant

2 Double-click Generate code and launch debugger.
Code is generated and the debugger is started.
3 Select View > Source > Source and Disassembly.

The example following shows a sample of the generated code.
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§ 1
I Wl O W AR & Mm[E

I 36 jl 0x104e ﬂ|c188_bitfields_step leource ard DisassemblyﬂlSource line step j
f* SubSystem: '-Root-/Latch Temperature Alarm' *f

f* Dutput and update for enable system: '-Root-/Latch Temperature Alarm' *f
if {alarms.temphlarmp {

EIW | 6. 2485 feise Bitkields stapjler THE "7 Dxrdde i, clee Biefislds stepgds T TTTTTTTTTTTT T
#* Constant: '<S2:fConstant2' *f
alarms. tempAlarnmiatched = {TRUE};

B[~ | 0.000% [cl66_bitfields step#39: BSET Oxfddc. 2

}

| | i

4 You can double-click Open setup file in the model to open the file
ci66bitfielddata.min the MATLAB editor.

File Edit Wiew Text Debug Breakpoints ‘Web ‘Window Help

DEdH| i@« | &M | 88|82 RE| s -] _|

1 I‘Zs CleeBITFIELDDATA create data for CLE6 bhitfield demo model =

2

3 % Copyright 2002 The MathWorks, Inc.

4 % gRewvision: 1.1 %

& % ghate: Z00Z710/703 09:45:24 5

A

7= cacdenoclearvs

g

9 - temphlarm = SimulinkClod, Signal;

10( - tenphlarm, BETWInfo. Custonhttributes.BitFieldNane = 'alarms';:

11

12|=| tempilarmlatched = SimulinkCl&66.Signal;

13— temphlarmlatched, RTWInfo. Custondttributes . EitFieldlane = 'alarms':

14

18- rpoilarm = SimulinkClés.3ignal;

16[ - rpm&larm. RTTInfo. Customdttributes.BitFieldNane = 'alarms';

17

18— rpmilarmLatched = SimulinkCle6.3ignal:

19— rpmilarnlLatched. RTWInfo. Custondttributes. . BicFieldlane = 'alarms’'; |l

20

21— templimit = wintle(500) ; =
1 I>|J

This file creates a new Simulink data object using the custom storage class
SimulinkC166.Signal. By using custom storage classes, you can collect
a number of input or output variables together into a C struct, resulting



Using the Bitfield Example Model

in more readable code. By defining your own custom storage classes, you
have complete control over the data structures that are used for any
signal in the model. See the custom storage class documentation in the
Real-Time Workshop Embedded Coder User’s Guide for more details. You
can double-click Read general documentation for custom storage
classes in the model to go directly to the relevant Real-Time Workshop
Embedded Coder help section.

5 You can double-click Inspect data objects to inspect all the Simulink data
objects that are available to the model.

& Model Explorer 101 x|
Eile Edit Yiew Tools Add Help

D/ smax/HHEwHfF0 DO 4R[S nrmara]
JJSE&TChZ Iby Block Type j Type: IConstanH LI Search

Madel Higrarchy Caortents of: Baze Workspace Basze Workspace
= EF]Simulink Root | M ame | DataType I Walue I Eomplexit}ll Dimensionsl Minl MaHl StorageClass | The base MATLAB) work:
1 Base Workspace € ouput_dig] auto auto 3 It ot C1GEBiFeld (Custom) || Jnies thal ae vishie lo
- E3E varnables can De us
188166_serial_transmit £ output_led_D3 auto auto 4 drf Irf CTEGBitFisld [Custom] certain model, block and 5
9166 _user_io £ mprblamlatched  auto auto 1 Inf Inf C1BEBiField [Custom]
r=l- W16 _bitfields £ tempblamlatched  auto auto 4 dnf Inf C1EGBitField (Custom)
A headerTest <1452 char>
B rprLimit R00
B3 temnpLimit 500
[i;}i] 1pmCheckE nabled true Anf Inf C1EEBitFigld (Custom)
[i,gg] tempCheckE nabled true Anf Inf C1BBBitField (Custam)
4| | 2l
| | || Eantents | Seanch Besults | Bevert | Helr
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Here you can see the SimulinkC166.Signal data object and you can click
on each object to inspect the properties.

6 One of the signals in the demo model c166_user_io also uses the custom
storage class SimulinkC166.Signal to specify that the signal uses
bit-addressable memory. Open c166_user_io.mdl.

7 Double-click Open custom storage class data file.
The file c166useriodata.m opens in the MATLAB editor.

File Edit WYiew Text Debug Breakpoints ‘Web Window Help

BH| B |G| @7 @,@|@@@1@@|sw|aase__[_|

% Cl66USERICDATA create data for Cléd user i/o demo model

% Copyright 2002 The MathWorks, Inc.
$Revision: 1.2 §
$Date: 2002710409 11:14:05 %

A

- output_led D3 = SimulinkClec6.Signal;
= output_led D3,.RTWInfo.Customdttributes.BitFieldlane = 'dig outputs':

L e =
A

[f=]

10— output_digl = SimulinkCl66, Signal;
11— output_digl.RTWInfo.Customdttributes,BitFieldNane = 'dig outputs';
12
13
1 o

I I c16Bhitfielddata.m c166useriodata.m |

Compare with c166bitfielddata.m.

For more details on the variables in this model, see “Tutorial: Using the
Example Driver Functions” on page 3-10.
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This section contains the following topics:

Overview of Execution Profiling
(p. 5-2)

Real-Time Workshop Options for
Execution Profiling (p. 5-4)

Multitasking Demo Model (p. 5-7)

The steps involved in performing
execution-profiling analysis on a
model.

How to configure options for
execution profiling.

Step-by-step-instructions for
running the multitasking demo and
interpreting the execution profiling
results.



5 Execution Profiling

Overview of Execution Profiling

Embedded Target for Infineon C166 Microcontrollers provides a set of utilities
for recording, uploading, and analyzing execution profile data for timer-based
tasks and asynchronous Interrupt Service Routines (ISRs). With these
utilities, you can

® Generate a graphical display that shows when timer-based tasks and
interrupt service routines are activated, preempted, resumed, and
completed.

® Generate a report with information on

= Maximum number of overruns for each timer-based task since model
execution began

= Maximum turnaround time for each timer-based task since model
execution began

= Analysis of profiling data for timer-based tasks and asynchronous
interrupts over a period of time

To perform execution-profiling analysis on a model, you must perform the
following steps:

1 Place a copy of the appropriate execution profiling block in your model:
¢ Execution Profiling via ASCO if using a serial connection
e Execution Profiling via CAN A if using CAN with a C166 processor

® Execution Profiling via TwinCAN A if using CAN with an XC16x
processor variant

2 Select the Execution profiling option under Real-Time Workshop options
in the Configuration Parameters dialog. See “Real-Time Workshop Options
for Execution Profiling” on page 5-4.

3 Connect the target processor to your host PC (with a serial or CAN cable).
4 Build, download, and run the model.

5 Initiate execution profiling by running the command profile c166.
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Two forms of execution profiling are provided:

1 The worst-case values for task turnaround times and number of concurrent
task overruns since model execution began are updated whenever a
previous worst-case value is exceeded.

2 A snapshot of task and ISR activity may be recorded over a period of time;
the length of this period depends on how much memory is reserved to log
the data.

Definitions

Task turnaround time is the elapsed time between start and finish of a
task. If the task is not preempted, then the task turnaround time is equal
to the task execution time.

Task execution time is that part of the time between task start and finish
when the task is actually running and not preempted by another task. Note
that the task execution time cannot be measured directly, but is inferred from
the task start and finish time and the intervening periods during which it was
preempted by another task. Note that, in performing these calculations, no
account is taken of processor time consumed by the scheduler while switching
tasks: this means that, in cases where preemption has occurred, the reported
task execution times will overestimate the true values.

Concurrent task overruns occur when a timer task does not complete
before that same task is next scheduled to run. Depending on how the
real-time scheduler is configured, a task overrun may be handled as a
real-time failure. Alternatively, a small number of concurrent task overruns
may be allowed to accommodate cases where a task occasionally takes longer
than normal to complete.

Execution Profiling Blocks
See the block reference sections:

® (166 Execution Profiling via ASCO
® (166 Execution Profiling via CAN A
* (166 Execution Profiling via TwinCAN A
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Real-Time Workshop Options for Execution Profiling

You can see these options by selecting C166 Options (1) (under Real-Time
Workshop in the tree) in the Configuration Parameters dialog.

E! Configuration Parameters: c166_user_io/Configuration ed |
Select: |
- Salver Build action: | Download_and_mun LI
Dat?a |.I‘I'||:I::Ilt.-"E:-:|DD[l Crozsiew startup options file:
- Optimization
=)~ Diagnostics ¥ Include input/output driver function hooks
i Sample T"Tfe taximurn number of concunent base-rate overruns: |5
-Drata Integrity
- Conversion t aximumm number of concurent sub-rate overuns: |1
- Connectivity v i
i Compatibility i
‘... Mode Freferencing Mumber of data points: {500
-~ Hardware [mplemertation v Use prebuilt RTW libraries
- Model Referencing
=] Real-Time Waorkshop
o Comments
-Symbolz
- Cugtom Code
-Diebug
Interface
-Templates
i Data Flacement
.. C16E Options [1]
Ok I LCancel Help Apply

Execution Profiling

If this option is selected, then the generated code for the model will be
“instrumented” with function calls at the beginning and end of each task or
ISR to be profiled. These function calls read a timer (on C166 a free running
timer is selected from the options in the C166 Resource Configuration block)
and log this reading along with a task identifier.



Real-Time Workshop Options for Execution Profiling

When code for the model is generated, these functions will update data

on the worst-case turnaround time for each timer-based task as well as

the worst-case number of concurrent task overruns, whenever a previous
worst-case value is exceeded. Additionally, when a trigger is provided, data
will be logged over a period of time to record all task start and finish times.
The trigger signal can be supplied, for example, by the block C166 Execution
Profiling via CAN A.

Number of Data Points

When a snapshot of task and ISR activity is logged, this data is stored in
memory that is statically allocated at build time. Each data point requires 4
bytes on C166. The larger the number of data points to be stored, the more
RAM that must be reserved for this purpose. At the end of a logging run, the
data must be uploaded to the host computer for analysis; this is typically
achieved by using one of the C166 execution profiling blocks — via ASCO,
CAN A, or TwinCAN A. See the reference pages for C166 Execution Profiling
via ASCO, C166 Execution Profiling via CAN A, and C166 Execution Profiling
via TwinCAN A.

Task Scheduler Overrun Options

These scheduler options configure the allowable number of concurrent task
overruns. You can see these options on the C166 Options (1) section in the
Configuration Parameters dialog.

E Configuration Parameters: c166_user_io/Configuration

Select: |

- Galver Build action: | Download_and_run

- Data Import/E xport
- O ptimization
[=]- Diagnostics v Include inputdoutput driver function hooks

Cross'iew startup options file:

Sample Time

. td awiniunn number of concurrent base-rate overruns: |5
Drata Intedrity

Correrzion I amimurn number of concurrent sub-rate overung: |1

Connectivity
v
Compatibility © H
- Model Referencing Mumber of data points: (500
- Hardware Implementation W Use prebuilt BT libraries

- Model Referencing

—m T
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You can use the options Maximum number of concurrent base-rate
overruns and Maximum number of concurrent sub-rate overruns to
configure the behavior of the scheduler when any of the timer based tasks do
not complete within their allowed sample time. It is useful to allow task
overruns in the case where a task may occasionally take longer than usual to
complete (e.g., if extra processing is required when a special event occurs);

if the task overrun is only occasional, then it is possible for the scheduler to
catch up after the extra processing has been completed.

If the maximum number of concurrent overruns for any task is exceeded, this
is deemed to be a failure and the real-time application is stopped.

As an example, if the base rate is 1 ms and the maximum number of
concurrent base-rate overruns is set to 5 then it is possible for the base rate
task to run for almost 6 ms before failure occurs. Once the overrun has
occurred, it is necessary for subsequent executions of the base rate to complete
in less than 1 ms in order that the lost time is recovered.

The occurrence of base-rate overruns does not affect the numerical behavior
of the algorithm (although reading/writing external devices will of course
be delayed).

If sub-rate overruns are allowed, then the transfer of data between different
rates (via rate-transition blocks) in the model may be affected; this

causes the numerical behavior in real time to differ from the behavior in
simulation. To see an illustration of this effect, try running the demo model
c166_multitasking, described in the next section. To disallow sub-rate
overruns and ensure that this effect does not occur, you should set Maximum
number of concurrent sub-rate overruns to zero.
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Multitasking Demo Model

The demo model c166_multitasking.mdl illustrates both execution profiling
and the preemptive multitasking scheduler with configurable overrun
handling.

The model is multirate, having tasks running at 1 ms, 4 ms, and 16 ms. It is
configured to use the preemptive multitasking scheduler.

A special feature of this model is that each task is designed to perform an
increasing number of calculations to increase the processor loading until
that task reaches a target turnaround time. This behavior ensures that task
overruns occur to demonstrate the behavior of the model in this situation.

Each block in the model, labeled Load base rate, Load sub-rate 1, Load
sub-rate 2 performs calculations, the result of which should always be 1
both in simulation and in real time. Any other result is a failure and should
never occur.

The Test Rate Interaction blocks are designed to test whether data is
transferred between tasks in a deterministic manner. In simulation, the
output of each of these blocks is always zero, indicating that there is no drift
between tasks running at different rates. When running in real time, under
normal circumstances, the output is also zero; in this case the real-time
behavior is deterministic and exactly matches the results in simulation. Even
if task preemption and base-rate overruns occur, the output of these blocks
will be zero so that the real-time behavior faithfully reproduces the results in
simulation. The circumstance under which drift occurs is if sub-rate overruns
occur during execution in real time; if this behavior is not desired, you should
disallow sub-rate overruns by setting the maximum allowed number of
sub-rate overruns to zero in the C166 Options (1) section in the Configuration
Parameters dialog (see “Task Scheduler Overrun Options” on page 5-5).

You can double-click the block provided in the model to switch between
profiling over serial or CAN connections.

Running the Multitasking Demo

1 Open the model by typing at the command line
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9

c166_multitasking.mdl

If viewing in the Help browser, you can click the link to open the model.
Select Simulation > Configuration Parameters.

The Configuration Parameters dialog appears.

Select C166 Options (1) under Real-Time Workshop in the tree.

Ensure the Build action is Download and_run , and click OK to dismiss
the dialog.

Make sure the target is connected to the host PC via serial or CAN cable.
The default setting in this demo model is serial. You can double-click the
Switch Execution Profiling Connection block to toggle between blocks for
serial and CAN. See below for instructions if using CAN.

To build and run the model, select the model window, and then press
Ctrl+B.

Watch the messages in the command window as code is generated, then
the CrossView Pro Debugger starts, connects to the target, and downloads
the code.

In the CrossView window, click Run in the toolbar to start the application
running on the target.

At the command line, type
profile c166 ('serial')
You will see messages in the command window as profile c166 runs.

When the data has been obtained the Help browser and a figure window
appear, displaying the HTML report and the task execution profile.

Scroll to view the HTML report on task timings and use the controls to zoom
in on the MATLAB graphic to examine the details of the task overruns.

If using CAN, be sure to use CAN channel 0 (not 1) on the PC. You can
double-click the Switch Execution Profiling Connection block in the model to



Multitasking Demo Model

switch to CAN, and follow the same instructions as for a serial connection,
except step 7 when the application is running. At the command line, type

profile c166 ('CAN')

You will see command line messages as the function tests the CAN channel,
and requests and collects profiling data. When using CAN, it can be useful to
run a monitor program such as btest32 to verify that the model is running —
for example you will see messages appearing on the CAN bus and you can see
that you have connected the correct CAN channel.

Interpreting the MATLAB Graphic

Dark shaded areas show the region where a task is executing. Light shaded
areas show the region where a task is preempted by a higher priority task
or ISR .Triangles indicate the beginning of a task. An example is shown
following.
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B Figure 1 B =)=
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Zoom in to see the details of times that tasks are executing and being
preempted, as shown in the following example.
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The Generated HTML Report

See “Definitions” on page 5-3 for the terms task turnaround time, task
execution time, and concurrent task overruns.

All times are in seconds. The timer resolution is 4e-007 seconds and the
measurement range is 0.026214 seconds.

The report contains the following information:

® Worst-case task turnaround times

5-11



5 Execution Profiling

= Maximum task turnaround time for each task since model execution
started. Note that the maximum task turnaround time that can be
measured is limited by the timer measurement range.

e Maximum number of overruns for each task

= Maximum number of concurrent task overruns since model execution
started

® Analysis of recorded profiling data

= Analysis of task turnaround times and task execution times based on
recorded data over a period of 0.18139 second
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Embedded Target for Infineon C166
Microcontrollers Block Library
(p. 6-2)

C166 Drivers Library (p. 6-3)

An overview of the C166 block
library structure.

Category tables for the blocks
contained in the C166 Drivers
library and sublibraries.
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Embedded Target for Infineon C166 Microcontrollers Block

Library

The Embedded Target for Infineon C166 Microcontrollers provides one block
library, containing seven sublibraries that support different functions. The
tables below reflect that organization:

® “C166 Drivers Library” on page 6-3

Asynchronous/Synchronous Serial Interface Sublibrary on page 6-4
CAN Interface Sublibrary on page 6-5

Execution Profiling Sublibrary on page 6-5

TwinCAN Interface Sublibrary on page 6-6

Interrupts Sublibrary on page 6-7

Utilities Sublibrary on page 6-7

Digital Input/Output Sublibrary on page 6-7

The following sections provide complete information on each block in the
Embedded Target for Infineon C166 Microcontrollers block libraries, in a
structured format. Refer to these pages when you need details about a specific
block. Click Help on the Block Parameters dialog for the block, or access the
block reference page through Help.
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C166 Drivers Library

Top-Level Library

Block Name Purpose

C166 Resource Configuration Support driver configuration for
C166 microcontrollers

The C166 Resource Configuration block provides information required for
generating timer interrupt code. If you do not include a C166 Resource
Configuration block in your model, the code simply executes as fast as
possible. That is, it is not synchronized to real time. This behavior may be
desirable if you are running code on the debugger/hardware simulator. The
C166 Resource Configuration block is required if there are device driver
blocks in the model.

Note When using device driver blocks from the Embedded Target for Infineon
C166 Microcontrollers libraries with the C166 Resource Configuration block,
do not disable or break library links on the driver blocks. If library links

are disabled or broken, the C166 Resource Configuration block operates
incorrectly. See the C166 Resource Configuration reference page for further
information.

Model Reference and driver blocks: Referenced sub-models that contain
driver blocks (including the C166 Resource Configuration block) cause build
failures. All driver blocks from the Embedded Target for Infineon C166
Microcontrollers must be placed in the top level model. It is not possible to
include driver blocks in any of the referenced sub-models.
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Asynchronous/Synchronous Serial Interface Sublibrary

Block Name

Purpose

Serial Receive

Configure C166 microcontroller for
serial receive

Serial Transmit

Configure C166 microcontroller for
serial transmit




C166 Drivers Library

CAN Interface Sublibrary

Block Name

Purpose

CAN Bus Status

Output the Bus Off or Error Warning
state of a CAN module

CAN Calibration Protocol (C166)

Implement the CAN Calibration
Protocol (CCP) standard

CAN Receive Receive CAN messages from the
CAN module on the Infineon C166
microprocessor

CAN Reset Reset a CAN module

CAN Transmit Transmit CAN messages via a CAN

module on the Infineon C166

You can also use the CAN message blocks that are part of the CAN Blockset.
See the CAN Blockset Reference for the following blocks:

Block Name

Purpose

CAN Message Filter

Dispatch message processing based
on message ID

CAN Message Packing

Map Simulink signals to CAN
messages

CAN Message Unpacking

Inspect and unpack the individual
fields in a CAN message

Execution Profiling Sublibrary

Block Name

Purpose

C166 Execution Profiling via ASCO

Provide a serial interface to the
execution profiling engine
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Execution Profiling Sublibrary (Continued)

Block Name

Purpose

C166 Execution Profiling via CAN A

Provide a CAN interface to the
execution profiling engine via CAN
channel A

C166 Execution Profiling via
TwinCAN A

Provide a CAN interface to the
execution profiling engine via
TwinCAN channel A, for XC16x
variants of the Infineon C166
microprocessor

TwinCAN Interface Sublibrary

Block Name

Purpose

CAN Calibration Protocol (C166,
TwinCAN)

Implement the CAN Calibration
Protocol (CCP) standard for XC16x
variants of the Infineon C166
microprocessor

TwinCAN Bus Status

Output the Bus Off or Error Warning
state of a CAN node on XC16x
variants of the Infineon C166
microprocessor

TwinCAN Receive Receive CAN messages via the
TwinCAN module on XC16x variants
of the Infineon C166 microprocessor

TwinCAN Reset Reset a CAN node on XC16x variants
of the Infineon C166 microprocessor

TwinCAN Transmit Transmit CAN messages from the

TwinCAN module on XC16x variants
of the Infineon C166 microprocessor
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Interrupts Sublibrary

Block Name

Fast External Interrupt

Purpose

Generate an asynchronous
function-call trigger when an
interrupt occurs

Utilities Sublibrary

Block Name
Switch Target Configuration

Purpose

Configure your model and Target
Preferences to one of a set of
predefined hardware configurations

Digital Input/Output Sublibrary

Block Name
Digital In

Digital Out

Purpose

Digital input driver that reads the
value of a specified port/pin number

Digital output driver that sets the
logical state of the specified pin

Configuration Class Blocks

Each sublibrary of the Embedded Target for Infineon C166 Microcontrollers
library contains a configuration class block that has an icon similar to the one

shown in this picture.

DOHNOT
COPY

CAGE
Configuration
Class
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Note Configuration class blocks exist only to provide information to other
blocks. Do not copy these objects into a model under any circumstances.

Using Block Reference Pages

Block reference pages are listed in alphabetical order by the block name. Each
entry contains the following information:

Purpose — describes why you use the block or function.
Library — identifies the block library where you find the block.
Description — describes what the block does.

Dialog Box — shows the Block Parameters dialog and describes the
parameters and options contained in the dialog. Each parameter or option
appears with the appropriate choices and effects.



Blocks — Alphabetical List




C166 Execution Profiling via ASCO

7-2

Purpose

Library

Description

Execution Profiling
via Serial

C1G6 Execution Profiling
wig ASCO

Provide a serial interface to the execution profiling engine

Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library/ Execution Profiling

The C166 Execution Profiling via ASCO block provides a serial interface
to the execution profiling engine. On receipt of a start command
message, logging of execution profile data begins. On completion of a
logging run, the recorded data is automatically returned via the serial
interface (ASCO). See also the MATLAB command profile c166.

profile c166('serial') collects and displays execution profiling
data from a C166 target microcontroller that is running a suitably
configured application generated by Embedded Target for Infineon
C166 Microcontrollers. The connection may be set to 'serial' in
order to collect data via a serial connection between the target and
the host computer.

The data collected is unpacked and then displayed in a summary HTML
report and as a MATLAB graphic.

profdata = profile_c166(connection)

returns the execution profiling data in the format documented by
exprofile unpack.

To configure a model for use with execution profiling, you must perform
the following steps:

1 Check the appropriate option in the Target Specific Options tab
of the Real-Time Workshop Options dialog.

2 Make sure the model includes a C166 Execution Profiling block that
provides an interface between the target-side profiling engine, and
the host-side computer from which this command is run.

For more information, see Chapter 5, “Execution Profiling” which
includes instructions for the example demo ¢c166_multitasking.mdl.
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Dlalog [=]Block Parameters: C166 Execution Profiling via 27| x|

Box —LC16E Execution Profiing wia Senal Port A5C0 [maszk] [link]

Provides a zenal interface to the execution profiing engine. On receipt of a start
command ko the zerial port, logging of execution prafile data is commenced. On
completion of & logging rin, the recorded data is automatically returned via zenal,

Mo other zerial blocks may be used in the model if an Execution Profiling via Serial
block iz present.

See alzo MATLAR command profile_c166.

—Parameters

S ample time:

1

(]4 Cancel Help Apply

Sample time
The sample time of the block. The faster the sample time of the
block, the faster data will be uploaded at the end of the execution
profiling run. You may want to run this block slower than the
fastest rate in the system because the execution profiling itself
imposes some loading on the processor. You can minimize this
extra loading by not running it at the fastest rate.
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Purpose
Library

Description

Execution
Frofiling

C1G6 Execution Profiling
wia CAN A

Provide a CAN interface to the execution profiling engine via CAN
channel A

Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library/ Execution Profiling

The C166 Execution Profiling via CAN A block provides a CAN interface
to the execution profiling engine. On receipt of a start command
message, logging of execution profile data begins. On completion of a
logging run, the recorded data is automatically returned via CAN. You
must specify the message identifiers for the start command and the
returned data. These identifiers must be compatible with the values
used by the host-side part of the execution profiling utility. See also the
MATLAB command profile c166.

profile c166(connection) collects and displays execution profiling
data from a C166 target microcontroller that is running a suitably
configured application generated by Embedded Target for Infineon C166
Microcontrollers. The connection may be set to 'CAN' in order to collect
data via a CAN connection between the target and the host computer.
To use the CAN connection, you must have suitable CAN hardware
installed on the host computer. This function tests for availability of
CanCardX 1 or CanAc2Pcil and defaults to a bit rate of 500K bits per
second. If you need to use a different configuration, you should make a
copy of this file (with a different name) and change the configuration
data as required. The data collected is unpacked then displayed in a
summary HTML report and as a MATLAB graphic.

profdata = profile_c166(connection)
returns the execution profiling data in the format documented by
exprofile unpack.
To configure a model for use with execution profiling, you must perform

the following steps:

1 Check the appropriate option in the Target Specific Options tab
of the Real-Time Workshop Options dialog.
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|

2 Make sure the model includes a C166 Execution Profiling block that
provides an interface between the target-side profiling engine, and
the host-side computer from which this command is run.

For more information, see Chapter 5, “Execution Profiling” which
includes instructions for the example demo ¢c166_multitasking.mdl.

Dla|og Block Parameters: C166 Execution Profiling A

Box — C166 Execution Profiling via CaM Channel A [mazk] (link]

Provides a CAM interface ta the execution profiing engine. On receipt of a
gtart command meszage, logging of execution profile data iz commenced.
On completion af a lagaging run, the recorded data iz autamatically
returned via T,

'ou mugt specify the meszage identifiers for the start command and the
returned data. These identifiers must be compatible with the values uzed
b the hozt-zide part of the execution profiling whlity, See alzo MATLAR
cammand profile_c1 66

— Parameters
Start command CAMN mezzage identifier:

Returned data CAMN meszsage identifier:
|he:<2u:|eu:['1 FFFFFO1"

Sample hime:

|
] 4 I Cancel Help Apply

Start command CAN message identifier
Set the identifier of the message to start logging execution
profiling data. You should use the default unless you have
modified profile_c166. This identifier must be compatible with
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the values used by the host-side part of the execution profiling
utility (profile c166).

The utility profile c166 provides a mechanism for initiating
an execution profiling run and for uploading the recorded data
to the host machine. To perform this procedure using a CAN
connection between host and target, profile c166 first sends a
CAN message that is a command to start an execution profiling
run. The CAN identifier for this message must be specified as the
same value on the target as on the host. The host-side values
are hard-coded in profile c166. If you are using an unmodified
version of the host-side utility, you should use the default value
for this CAN message identifier. These are visible to help you
avoid using the same identifier for other tasks.

Returned data CAN message identifier

Set the message identifier for the returned data. As with the
message identifier for the start command, the value specified here
must be the same as the hard-coded value in profile c166.

Sample time

The sample time of the block. The faster the sample time of the
block, the faster data will be uploaded at the end of the execution
profiling run. You may want to run this block slower than the
fastest rate in the system because the execution profiling itself
imposes some loading on the processor. You can minimize this
extra loading by not running it at the fastest rate.



C166 Execution Profiling via TwinCAN A

Purpose
Library

Description

Execution Profiling
wvia CAN

C1G6 Execution Profiling
wia TwinCAN A

Provide a CAN interface to the execution profiling engine via TwinCAN
channel A, for XC16x variants of the Infineon C166 microprocessor

Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library/ Execution Profiling

The C166 Execution Profiling via TwinCAN A block is for the TwinCAN
interface and performs the same functions as the C166 Execution
Profiling via CAN A block. For block parameter descriptions, see the
C166 Execution Profiling via CAN A reference page.
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Purpose

Library

Description

Support device configuration for the C166 microcontroller

Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library

The C166 Resource Configuration block differs in function and behavior
from conventional blocks. Therefore, we refer to this block as the C166
Resource Configuration object.

The C166 Resource Configuration object is required to provide
information that is used to configure driver blocks and timer interrupts.

® You must include this block in your model if

= You are using any of the driver blocks supplied with Embedded
Target for Infineon C166 Microcontrollers

= You are taking advantage of the automatically generated scheduler
that is driven by timer interrupts.

® You do not need to include the C166 Resource Configuration object in
your model if you are not using any of the C166 driver library blocks,
and if you do not require the automatically generated scheduler (for
example, if you are supplying your own main.c).

The C166 Resource Configuration object maintains configuration
settings that apply to the C166 microcontroller. Although the C166
Resource Configuration object resembles a conventional block in
appearance, it is not connected to other blocks via input or output ports.
This is because the purpose of the C166 Resource Configuration object is
to provide information to other blocks in the model. C166 device driver
blocks register their presence with the C166 Resource Configuration
object when they are added to a model or subsystem; they can then
query the C166 Resource Configuration object for required information.

To install a C166 Resource Configuration object in a model or
subsystem, open the C166 Drivers library and select the C166 Resource
Configuration icon. Then drag and drop it into your model or subsystem,
like a conventional block.
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Having installed a C166 Resource Configuration object into your model
or subsystem, you can then select and edit configuration settings in the
C166 Resource Configuration window. See “Using the C166 Resource
Configuration Window” on page 7-10 for further information.

Note If your model or subsystem requires a C166 Resource
Configuration object (see above), you should place it at the top-level
system for which you are going to generate code. If your whole

model is going to run on the target processor, put the C166 Resource
Configuration object at the root level of the model. If you are going to
generate code from separate subsystems (to run specific subsystems on
the target), place a C166 Resource Configuration object at the top level
of each subsystem. You should not have more than one C166 Resource
Configuration object in the same branch of the model hierarchy. Errors
will result if these conditions are not met.

Types of Configurations

A configuration is a collection of parameter values affecting the
operation of one or more device driver blocks in the Embedded Target
for Infineon C166 Microcontrollers library. The C166 Resource
Configuration object currently supports the following types of
configurations:

® (166 Drivers Configuration: C166 microcontroller clocks and other
CPU-related parameters

® Asynchronous/Synchronous Serial Interface Configuration:
parameters related to the serial driver blocks and Simulink external
mode

® CAN Configuration Parameters: parameters for CAN interrupt levels

Dialog The C166 drivers configuration always appears in the active
Box configuration pane. If there are also blocks in your model from the
Asynchronous/Synchronous Serial Interface (ASCO) sublibrary, you
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will also see the configuration for these, as seen in the next example.

If you add an ASCO block to a model without any ASCO blocks, the
appropriate configuration is created and activated in the C166 Resource
Configuration block. Similarly, if you add CAN blocks to a model, a
CAN configuration is created.

You can see an example like this by opening the demo model
c166_serial transmit and double-clicking on the C166 Resource
Configuration block.

A configuration remains active until all blocks associated with it are
removed from the model or subsystem. At that point, the configuration
is in an inactive state. Inactive configurations are lost from the C166
Resource Configuration window when the model is saved and reopened.
You can reactivate a configuration by simply adding an appropriate
block into the model.

Using the C166 Resource Configuration Window

To open the C166 Resource Configuration window, install a C166
Resource Configuration object in your model or subsystem and
double-click on the C166 Resource Configuration icon. The C166
Resource Configuration window then opens.

This example shows the C166 Resource Configuration window for a
model that has active configurations for the C166 microcontroller
(c166drivers) and for the Asynchronous/Synchronous Serial Interface
(ASCO) blocks, as found in the demo c166_serial transmit.
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<} C166 Resource Configuration =10l x|
Active Configurations |' System Configuration |
ERETE N SR BT
1 BEdriversidsynchronousiSynchronous Serial Interface Free_running_timer :I Maone
Systermn_freguency 200000000
System_timer :|T3, reload fram T2
Timer_interrupt_level :I 7
Timer_interrupt_level_group :l 0
« | 2
Stetus |
0K : =
QK | Apply | Help |

The C166 Resource Configuration window consists of the following
elements:

® Active Configurations panel: This panel displays a list of currently
active configurations. To edit a configuration, click its entry in the
list. The parameters for the selected configuration then appear in the
System Configuration panel.

To link back to the library associated with an active configuration,
right-click its entry in the list. From the menu that appears, select
Go to library.

To see documentation associated with an active configuration,
right-click its entry in the list. From the menu that appears, select
Help.

¢ System Configuration panel: This panel lets you edit the
parameters of the selected configuration. The parameters of each
configuration type are detailed in “C166 Resource Configuration
Window Parameters” on page 7-12.
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Note Click Apply to make your changes take effect.

e Status panel: The Status panel displays error messages that may
arise if resource allocation conflicts are detected in the configuration.

¢ OK button: Dismisses the window.

C166 The following sections describe the parameters for each type of
Resource configuration in the C166 Resource Configuration window. The default
Configuration parameter settings are optimal for most purposes. If you want to change
Window the settingg, read the relevant sections of thg C166 User’s Mgnual. You
Parameters can find this document at the Infineon Web site at the following URL:

http://www.infineon.com/

C166 System Configuration Parameters

=IEY
i i I System Configuratian |
; External_oscillator_fregquency a000000.0
1 BGdriversidsynchronousiSynchronous Serial Interface Free_running_timer ﬂ MHone
System_frequency 200000000
Systerm_timer :|T3, reload from T2
Timer_interrupt_level ﬂ T
Timer_interrupt_level_group :l I}
| | >l
Stetus |
0K : ﬁ
Ok | Apply | Help |

External_oscillator_frequency
Depending on your hardware variant, the Real-Time Clock (RTC)
may be driven directly by the external oscillator input and it is,
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therefore, important that the external oscillator frequency is set
correctly. Otherwise, if the RTC is used to provide any timing
services, the behavior will be incorrect. The default value for
external oscillator frequency is 5 MHz. You should check your
hardware manual to establish the correct value for your setup.
Note you can choose the RTC as a System_timer, see below.

Free_running_timer
This parameter allows one of the on-chip timers to be configured
for use with execution profiling. The selected timer is configured to
run indefinitely at a known frequency and is used by the execution
profiling engine to record the times at which tasks start or finish
executing. See Chapter 5, “Execution Profiling” for more details.

System_frequency
You must set the system frequency of your C166 microcontroller
hardware here. Note that the value depends on your hardware
type and configuration. If you choose an incorrect value the model
will be correspondingly fast or slow.

System_timer
You must select which timer to use for generating interrupts to
drive the model update rate. You should select a timer, or timer
pair, that you do not intend to use for any other purpose within
your application. We recommend you choose a pair of timers, e.g.,
T6, with reload from CAPREL. This will give the best possible
sample time accuracy with no long term drift caused by higher
priority interrupts. If you choose a single timer, e.g., T2 or RTC,
the timer value will be reloaded within the timer interrupt service
routine. With this approach, any delay in servicing the timer
interrupt will be added to the time until the next timer interrupt
is generated.

Timer_interrupt_level and Timer_interrupt_level_group
These two parameters together set the priority of sample time
interrupts. You should choose values such that the sample time
interrupts are suitably prioritized relative to other interrupts
used by your application.
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Asynchronous/Synchronous Serial Interface Configuration

Parameters

<} C166 Resource Configuration

I Active Configurations

|<

=101 x]

Asyhchronous/Synchrohous Serial Configuration |

chronal

A

— Bit_rate_achieved

— Bit_rate_ideal

— Loopback_mode_enahle

— Mode_control

— Parity_selection

— Receive_huffer_size

— Receive_interrupt_level

— Receive_interrupt_level_group
— S0CON

— Stap_hits

— Transrmit_huffer_size

— Transmit_interrupt_level

L Transrmit_interrupt_level_graup

9615385
8600.0
:l Standard transmitireceive mode
:I 3-hit data, asynchronaous
| i
32
=14
~|1
0x8011
;l One stop bit
32
|14
~lo

Status

0E :

Bit_rate_achieved
This read-only field shows the achieved serial interface bit rate. In
general, this value differs slightly from the requested bit rate, but
is the closest value that can be achieved by setting allowed values
in C166 register SOBG and bitfield SOBRS of register SOCON.

Bit_rate_ideal

Enter the desired bit rate for serial communications in this field.
Appropriate register settings are calculated automatically. You
can verify the actual bit rate in the Bit_rate_achieved field.
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Loopback_mode_enable
Select this entry to operate the serial interface in loopback mode.
This may be useful for test purposes where the serial interface is
required to receive data that it transmitted itself.

Mode_control
Select the desired combination of word length and parity/no
parity. See the C166 User’s Manual for more details.

Parity_selection
If parity is enabled, you must select odd or even.

Receive_buffer_size
You must select the size of the RAM buffer that will be used by
the serial receive driver. The maximum allowed value is 254.

Receive_interrupt_level and Receive_interrupt_level_group
Set the receive interrupt priority here. Note that the drivers used
by Embedded Target for Infineon C166 Microcontrollers allow
only interrupt levels 14 and 15 to be used. The reason for this is
that the drivers use the peripheral event controller (PEC), which
provides very fast interrupt response but is restricted to levels
14 and 15.

SOCON
This is a noneditable field that shows the value of the serial
interface register SOCON and how it varies as dialog settings
are changed.

Stop_bits
You must select either 1 or 2 stop bits.

Transmit_buffer size
See Receive buffer_size.

Transmit_interrupt_level and Transmit_interrupt_level_group
See Receive parameters above.

7-15



C166 Resource Configuration

CAN Configuration Parameters

<) C166 Resource Configuration ;lglﬁ

o1 EBdrivers =1 CAN_A c166Config. CAN_FROPS
1 66 i | Interface — C166_Transmit_Buffer_Murmber 14
—— CAMN_Int_Level_Group ﬂ1
— CARN_Interrupt_Level :I 10
- Masks c1B6Config CAN_MASKS
— Buffer_14_Mask 1FFFFFFF
— Global_kask_Edended 1FFFFFFF
— Global_kMask_Standard TFF
- Module_Enabled [ True
= Timing c1B6Config CAN_TIMING
— CAR_Bit_Rate A00000.0
— Mumber_Of_Quanta 20
— Resychronization_Jump_Width 4
— Sample_Faint 081
L Transmit_Gueue_Length 16
[+ CAN_B c166Config. CAN_PROPS

- T

Status
(1) A

I

Ok | Apply | Help

The parameters listed below are the same for CAN modules A and B.

C166_Transmit_Buffer Number
This parameter is read only; all transmitted messages are sent
from buffer 14.

CAN_Int_Level_Group and CAN_Interrupt_Level
These two parameters together set the priority of sample time
interrupts. You should choose values such that the sample time
interrupts are suitably prioritized relative to other interrupts
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Masks

used by your application. Note that CAN module interrupts

must be set to a higher priority than timer interrupts. Use the
Validate Configuration button to make sure you do not select

an interrupt level that is already in use.

You can use these mask configuration parameters to choose to ignore

certain bits. In general, a CAN message is received only if its identifier

is an exact match with the identifier specified in one of the receive

buffers. You can use mask parameters to indicate that some of the bits

in the received message identifier are “don’t care.”

Buffer 15 Mask

This mask applies to buffer 15 only. Each bit in the mask that is
set to zero causes the corresponding bit in the received message

identifier to be ignored when comparing it to the message identifer

that buffer 15 is configured to receive.
Global_Mask_Extended

This mask applies to any of buffers 1 to 14 that are configured

to receive messages with an extended identifier. Each bit in

the mask that is set to zero causes the corresponding bit in the

received message identifier to be ignored when comparing it to the

message identifer that this buffer is configured to receive.
Global_Mask_Standard

This mask applies to any of buffers 1 to 14 that are configured

to receive messages with an standard identifier. Each bit in

the mask that is set to zero causes the corresponding bit in the

received message identifier to be ignored when comparing it to the

message identifier that this buffer is configured to receive.
Module Enabled

If the module is enabled, then initialization code for that CAN
module is generated. Use this setting to prevent generation of

driver code for a CAN module that is not required, or not available

on your hardware variant.
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Timing

CAN_Bit _Rate
Enter the desired bit rate. The default bit rate is 500000.

Number_ Of Quanta
The number of CAN module clock ticks per message bit.

Resynchronization_Jump_Width
The maximum number of clock ticks that the CAN device can
resynchronize over when it detects that it is losing message
synchronization.

Sample_Point
The point in the message where the CAN module samples the
value of the message bit.

Transmit_Queue_Length
Length (number of messages) of the transmit queue. The transmit
queue holds messages that are waiting to be transmitted. An
increase in performance can be achieved by reducing the queue
length. However, if the queue’s length is too small, it may become
full, causing messages to be lost.



CAN Bus Status

Purpose

Library

Description

CAH_A
Blus Off Status

CAN Bus Status

Dialog
Box

Output the Bus Off or Error Warning state of a CAN module

Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library/ CAN Interface

The CAN Bus Status block provides an indicator of the state of the
selected CAN module. The block has a single output that may be set to
indicate either the Bus Off or Error Warning state of the module.

Block Parameters: CAM Bus Stakus |

— 166 CAM Bus Status [maszk] [link]

I1ze thiz block to determing if the CAM contraller is in either Buz OFF state
aor Emmor ' arning state.

— Parameters
Mochil: | - |
Status bype: IBus aff j
Sample time;

|1

[~ Ernable pass through [show simulation input]

k. I Cancel Help Apply

Module
Select CAN module A or B.

Status type
Choose Bus Off or Error Warning.
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Sample time
The sample time of this block.
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Purpose Implement the CAN Calibration Protocol (CCP) standard

Library Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library/ CAN Interface

Description The CAN Calibration Protocol (C166) block provides an implementation
of a subset of the CAN Calibration Protocol (CCP) Version 2.1. CCP is a
protocol for communicating between the target processor and the host
ECP machine over CAN. In particular, a calibration tool (see “Compatibility
with Calibration Packages” on page 7-26) running on the host can
communicate with the target, allowing remote signal monitoring and
parameter tuning.

CAN Calibration Frotocal

This block processes a Command Receive Object (CRO) and outputs
the resulting Data Transmission Object (DTO) and Data Acquisition
(DAQ) messages.

For more information on CCP, refer to ASAM Standards: ASAM MCD:
MCD Ia on the Association for Standardization of Automation and
Measuring Systems (ASAM) Web site at http://www.asam.de.

Using the DAQ Output

The DAQ output is the output for any CCP Data Acquisition (DAQ) lists
that have been set up. You can use the ASAP2 file generation feature of
the Real-Time (RT) target to

® Set up signals to be transmitted using CCP DAQ lists.

® Assign signals in your model to a CCP event channel automatically
(see “Generating ASAP2 Files” on page 2-16).

Once these signals are set up, event channels then periodically fire
events that trigger the transmission of DAQ data to the host. When this
occurs, CAN messages with the appropriate CCP/DAQ data appear on
the DAQ output, along with an associated function call trigger.

The calibration tool (see “Compatibility with Calibration Packages” on
page 7-26) must use CCP commands to assign an event channel and
data to the available DAQ lists, and interpret the synchronous response.
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Using DAQ lists for signal monitoring has the following advantages
over the polling method:

® There is no need for the host to poll for the data. Network traffic is
halved.

® The data is transmitted at the correct update rate for the signal.
Therefore, there is no unnecessary network traffic generated.

e Data is guaranteed to be consistent. The transmission takes
place after the signals have been updated, so there is no risk of
interruptions while sampling the signal.

Note The Embedded Target for Infineon C166 Microcontrollers does
not currently support event channel prescalers.
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Dialog
Box

=] Block Parameters: CaN Calibration Protocol
—CAM Calibration Protocal [C166] [maszk] [link]
Irmplements CAM Calibration Pratocal [CCP w2.1] an the target processor.

Thiz block proceszes Command Receive Object [CRO] meszages and outputs the
rezulting Data Tranzmizzion Object [DTO] and Data Acquizsition [DAGD] meszages.

—Parameters

CCP station addresz [16-bit integer];
|hexzdecl1]

CAM rnodule: I,&. ;I
CAM meszage identifier [CROT:

|hex2declBFA]

CAM meszage tpe [CRO]: I Extended [29-bit identifier) LI
CAM messzage identifier [DTO/DAL]:

|hex2dec6FE')

CaM meszage wpe [DTO/DAR]: I Extended [29-bit identifier] ;I
T atal Mumber of Object Descriptor Tables [ODT z):

B
CRO zample time:

|01

(B].4 Cancel Help Apply

CAN station address (16 bit integer)

The station address of the target. The station address is
interpreted as a uint16. It is used to distinguish between

different targets. By assigning unique station addresses to targets

sharing the same CAN bus, it is possible for a single host to
communicate with multiple targets.
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CAN module
Choose CAN module A or B.

CAN message identifier (CRO)
Specify the CAN message identifier for the Command Receive
Object (CRO) message you want to process.

CAN message type (CRO)
The incoming message type. Select either Standard(11-bit
identifier) or Extended(29-bit identifier).

CAN message identifier (DTO/DAQ)
The message identifier is the CAN message ID used for Data
Transmission Object (DTO) and Data Acquisition (DAQ) message
outputs.

CAN message type (DTO/DAQ)
The message type to be transmitted by the DTO and DAQ
outputs. Select either Standard(11-bit identifier) or
Extended(29-bit identifier).

Total number of Object Descriptor Tables (ODTs)
The default number of Object Descriptor Tables (ODTs) is 8.
These ODTs are shared equally between all available DAQ lists.
You can choose a value between 0 and 254, depending on how
many signals you wish to log simultaneously. You must make sure
you allocate at least 1 ODT per DAQ list, or your build will fail.
The calibration tool will give an error message if there are too few
ODTs for the number of signals you specify for monitoring. Be
aware that too many ODTs can make the sample time overrun.
If you choose more than the maximum number of ODTs (254),
the build will fail.

A single ODT uses 56 bytes of memory. Using all 254 ODTs would
require over 14 KB of memory, a large proportion of the available
memory on the target. To conserve memory on the target, the
default number is low, allowing DAQ list signal monitoring with
reduced memory overhead and processing power.



CAN Calibration Protocol (C166)

As an example, if you have five different rates in a model, and you
are using three rates for DAQ, then this will create three DAQ
lists and you must make sure you have at least three ODTs. ODTs
are shared equally among DAQ lists and, therefore, you will end
up with one ODT per DAQ list. With less than three ODTs, you
get zero ODTs per DAQ list and the behavior is undefined.

Taking this example further, say you have three DAQ lists with
one ODT each, and start trying to monitor signals in a calibration
tool. If you try to assign too many signals to a particular DAQ list
(that is, signals requiring more space than seven bytes (one ODT)
in this case), then the calibration tool will report this as an error.

CRO sample time

The sample time for CRO messages.

Supported CCP Commands

The following CCP commands are supported by the CAN Calibration
Protocol (C166) block:

CONNECT
DISCONNECT
DNLOAD
DNLOAD_6
EXCHANGE_ID
GET_CCP_VERSION
GET_DAQ_SIZE
GET_S_STATUS
SET_DAQ_PTR
SET_MTA
SET_S_STATUS
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* SHORT_UP

* START_STOP

* START_STOP_ALL
o TEST

* UPLOAD

e WRITE_DAQ

Compatibility with Calibration Packages

The above commands support

® Synchronous signal monitoring via calibration packages that use
DAQ lists

® Asynchronous signal monitoring via calibration packages that poll
the target

® Asynchronous parameter tuning via CCP memory programming

This CCP implementation has been tested successfully with the
Vector-Informatik CANape calibration package running in both DAQ
list and polling mode, and with the Accurate Technologies, Inc., Vision,
calibration package running in DAQ list mode. (Note that Accurate
Technologies, Inc., Vision does not support the polling mechanism for
signal monitoring).



CAN Calibration Protocol (C166, TwinCAN)

Purpose Implement the CAN Calibration Protocol (CCP) standard for XC16x
variants of the Infineon C166 microprocessor

Library Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library/ CAN Interface

Description The CAN Calibration Protocol (C166, TwinCAN) block is for the
TwinCAN interface and performs the same functions as the CAN
cop Calibration Protocol (C166) block. For block parameter descriptions, see
(TuinCAN) the CAN Calibration Protocol (C166) reference page.

CAN Calibration Frotocal
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Purpose Receive CAN messages from the CAN module on the Infineon C166
microprocessor
Library Embedded Target for Infineon C166 Microcontrollers/ C166 Driver

Library/ CAN Interface

Description The CAN Receive block receives CAN messages from a CAN module.
The CAN Receive block can reserve one of the buffers on the CAN
module. Alternatively, you can instruct the CAN Receive block to select
a hardware buffer automatically from the available buffers. The CAN
Receive block has two outputs: a data output and a function-call trigger
output. The CAN Receive block polls its message buffer at a rate
determined by the block’s sample time. When the CAN Receive block
detects that a message has arrived, the function-call trigger is activated.
You should use a function-call subsystem, activated by the trigger, to
decode the message available at the CAN Receive block data output.

(]
Dialog 2l

Box —C16E CAM Receive [maszk] (link)

Receives CAM meszages from the selected CAM module.

—Parameters

AN module: [

CAM meszage identifier:
|hex2decrnnm )

Buffer selection: I Automatic LI
Buffer number [1..15]:
h

CAM meszage type: I Standard [11-bit identifier] ;I

Sample tirme:

1

oK Cancel Help Apply
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CAN module
Select CAN module A or B. The CAN modules can receive
messages independently.

CAN message identifier
The identifier of the message you want to receive. Note that if you
have set the CAN configuration parameters in your model to mask
out certain bits (e.g., the message identifier field), you may receive
messages with identifiers other than the identifier specified here.
See “CAN Configuration Parameters” on page 7-16.

Buffer selection
Choose Automatic or Manual. When the automatic option is
selected, the CAN Receive block automatically selects a receive
buffer from the available buffers. Use this automatic buffer
selection, unless you want to use buffer 15 with its individually
programmable mask.

Buffer number [1..15]
This field is enabled if the Buffer selection is Manual. The buffer
number specifies the identifier of the receive buffer for this block.
Select Automatic buffer selection instead of manually specifying
the buffer, unless you want to use buffer 15 with its individually
programmable mask.

CAN message type
The type of message you want to receive. Select either
Standard(11-bit identifier) or Extended(29-bit
identifier).

Sample time
Determines the rate at which to sample the buffer to see if a new
message has arrived.
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Note The CAN Receive block sample time must be set to a value
that is smaller than the minimum time between CAN messages
that will be received into the corresponding buffer. If more than
one message is received into a buffer during a single sample
interval, the older message will be overwritten.
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CAN Reset

Purpose

Library

Description

CAM_A
Resat

CAN Reset

Dialog
Box

Reset a CAN module

Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library/CAN Interface

The CAN Reset block reinitializes the CAN module. We recommend
that you place this block in a triggered subsystem, with a sample time
of -1 (inherited).

Block Parameters: CAN Reset k|

—C166 CAM Bug Statuz [mazk] [link]

I1ze thiz block ta determine if the CAM contraller is in either Buz OFF state
ar Error YW arning state.

— Parameters
oct: [ - |
Sample hime;

[
k. I Cancel Help Lpply

Module
Select CAN module A or B.

Sample time
The sample time of this block.
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Purpose Transmit CAN messages via a CAN module on the Infineon C166

Library Embedded Target for Infineon C166 Microcontrollers/C166 Driver
Library/CAN Interface

Description The CAN Transmit block transmits a CAN message onto the CAN bus.
Three modes of transmission are available with the CAN Transmit
block.

CAN_A

ul.
=d Tranzmit

The default mode is to use a priority-based message queue shared by
all transmit blocks operating in this mode; the priority-based message
queue operates with CAN buffer 14; when a message is successfully
transmitted from this buffer, an interrupt is generated and the highest
priority message from the queue is loaded into the hardware buffer
ready to be transmitted. This mode has the advantage of allowing
several messages with different identifiers to be transmitted without
each message requiring a dedicated hardware buffer. Note that
although messages are taken from the queue in order of priority, it is
possible for a low priority message to be present in the hardware buffer
and higher priority messages cannot then be transferred from the queue
until transmission of the low priority message is complete.

CAN Transmit

The second transmit mode is to use a dedicated CAN buffer; in this
case, messages to be transmitted are loaded directly into a CAN
buffer that is used exclusively by the block. No queue is used, which
means that in case the previous message has not been transmitted,
it will be overwritten by the new one. This transmit mode does not
use interrupts. An advantage of using the dedicated buffer mode is
that there is reduced delay in transmitting high-priority messages,
and reduced processor overhead that is otherwise required for queue
management and servicing interrupts.

The third transmit mode is to use a First In First Out (FIFO) queue
with dedicated buffer. In this mode, messages are placed in a queue
and then transmitted on a first in, first out basis. This mode is useful
if several messages, possibly with the same CAN identifier, must be
transmitted in sequence; this may be a requirement if CAN is being
used for data acquisition.
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|

The CAN Transmit block should be connected to CAN Message
Packing/Unpacking blocks. Do not ground the block or leave it
unconnected.

Dialog 21
Box —C166 CAM Tranzmit [mazk] [link]

Transmits a CAM meszage via the selected CAN module.

—Parameters

adule: [ - |

Tranzrnit rode: I [ueued tranzmizgion with ghared buffer ;I

Sample tirme;

|-

ok LCancel Help Apply
Module

Select CAN module A or B.. The CAN modules can receive
messages independently.

Transmit mode
Select one of the three modes described above: queued
transmission with shared buffer, direct transmission with
dedicated buffer, or FIFO queue with dedicated buffer.

Buffer selection
Only for selecting dedicated buffers — available only if you select
direct transmission or FIFO queue transmit modes. Choose either
automatic or manual selection of the hardware buffer number.

Buffer number
This option is available only if the buffer selection is available and
set to manual. You must select a buffer number between 1 and
14. Note if more than one message is ready to be transmitted,
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then the one in the lower buffer number will be sent first. Select
buffer numbers such that the higher the message priority, the
lower the buffer number.

Sample time
Choose -1 to inherit the sample time from the driving blocks. The
CAN Transmit block does not inherit constant sample times and
runs at the base rate of the model if driven by invariant signals.
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Digital In

Pu rpose Digital input driver that reads the value of a specified port/pin number
Library Embedded Target for Infineon C166 Microcontrollers/C166 Driver
Library/Digital Input/Output
Description
Digital In L
on FE.O
Digital In
The Digital In block reads the logical state of the specified pin and
outputs a value of zero or one accordingly.
Source Block Parameters: Digital In x
Dlalog lock I [
Box — 166 Driaital Input [mask] (link]
Feads the logical state of the specified pin and outputz a walue of zero or one
accardingly.

The pin muszt be an integer value in the range 0 to 7 for ports that are 8 bitz wide ar 0
ko 15 fior ports that are 16 bits wide.

—Parameters
Par :
Fir:
o
Sample tirme:
01

k. Cancel Help
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Port
Select a port. Options are POL, POH, P1L, P1H, P2—P8.

Pin
The pin must be an integer value in the range 0 to 7 for ports that
are 8 bits wide, or 0 to 15 for ports that are 16 bits wide.

Sample time
The time interval between samples. The default is 0.1. See
“Specifying Sample Time” in the Simulink documentation for
more information.
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Purpose

Library

Description

Drigital Cut
on P20

Digital Cut

Dialog
Box

Digital output driver that sets the logical state of the specified pin

Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library/ Digital Input/Output

The Digital Out block sets the logical state of the specified pin according
to the input signal. When the input signal is greater than zero, a logical
one is written to the selected pin; otherwise a logical zero is written.

E! Sink Block Parameters: Digital Out
— 166 Digital Output [maszk] [link]

Sets the logical state of the specified pin. *hen the input zignal iz greater than zero a
lagical ane iz written ta the zelected pin; atherwize a lagical 2era iz wiitken,

The pin muzt be an integer walue in the range O to 7 for ports that are 8 bitz wide or 0
ko 15 for ports that are 16 bits wide.

—Parameters
Fort. [T |
Pir:
o
S ample time:
[
(] Cancel Help Apply
Port

Select a port. Options are POL, POH, P1L, P1H, P2—P8 (not P5).
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Pin
The pin must be an integer value in the range 0 to 7 for ports that
are 8 bits wide, or 0 to 15 for ports that are 16 bits wide.

Sample time
The time interval between samples. The default is -1, inherited.
See “Specifying Sample Time” in the Simulink documentation for
more information.
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Fast External Interrupt

Purpose
Library

Description

Fazt External
Interrupt an P2.2

F ast External Interrupt

Dialog
Box

Generate an asynchronous function-call trigger when an interrupt
occurs

Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library/ Interrupts

The Fast External Interrupt block executes a function-call triggered
subsystem in the context of the service routine for a fast external
interrupt. To generate the interrupt, you must select one of the upper
eight pins of Port 2 (P2.8 to P2.15)

The function-call subsystem will be executed as an asynchronous
task. Use this block to assign the task a Simulink priority and a CPU
interrupt level. The settings that you assign must be consistent with
priorities and interrupt levels of other tasks defined in the model.

Port 2 pin number
Select a port. Options are 8 to 15.

Trigger mode
Select from Rising or falling edge (the default), Rising edge,
Falling edge, or Disabled.

Priority
Set a Simulink priority. The default is 30.

Interrupt level
Select an interrupt level from 1 to 15. The default is 5.

Interrupt level group
Select an interrupt level group from 0 to 3. The default is 1.
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Show simulation input
Select this check box (and click Apply) to get an input port for
simulation.
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Serial Receive

Purpose

Library

Description

Configure C166 microcontroller for serial receive

Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library/ Asynchronous/Synchronous Serial Interface

The Serial Receive block receives bytes over the C166 microcontroller
Synchronous/Asynchronous Serial Interface ASCO. It requests either a
fixed number of bytes to be received, or by enabling the first input, a
variable number of bytes can be requested each time this block is called.

When the block is called, the requested number of bytes are retrieved
from a FIFO buffer that is internal to the device driver. If this buffer
contains fewer bytes than the number requested, these bytes are pulled
from the buffer and made available at the block output. The number of
bytes actually retrieved from the buffer is made available at the second
output. This block retrieves only those bytes that have already been
received and placed in the internal buffer; it never waits for additional
data to be received.

Whenever bytes are received at the serial interface, a Peripheral Event
Controller (PEC) interrupt is generated to move the byte into the
internal buffer. If there is no more space available in the internal buffer,
any additional data is lost. The PEC interrupts are extremely fast and
have minimal effect on the rest of the application.

To configure the serial interface bit rate, buffer size, PEC interrupt
priority, and other parameters, see “Asynchronous/Synchronous Serial
Interface Configuration Parameters” on page 7-14.
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Note If your model contains a serial transmit or receive block, it is not
possible to perform on-chip debugging over the same serial interface.
Attempting to use the debugger in this case causes an error. If you
need to debug an application that includes the serial transmit and
receive blocks, you must run the debugger using a hardware simulator;
alternatively, it may be possible to run your debugger on-chip without
using the serial interface, for example, if debugging over CAN is
available. See “Starting the Debugger on Completion of the Build
Process” on page 2-12.

Block Inputs and Outputs

The input can be enabled so a variable number of bytes can be requested
each time.

The first output pulls bytes from the buffer — either the number
requested or the number available, whichever is the lower. Note that
the number requested is the value of input signal if supplied, or the
width of output signal otherwise.

The second output is the number of bytes actually retrieved from the
buffer.
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D|°|°9 Block Parameters: Serial Receive B
Box I

— Parameters
v Shaow number of bytes read:

[ Show length input:
k axirmurn length of data:
|

Sample time;

|1

| k. I Caricel Help F¥u]m 1]

Show number of bytes read
Enables second output to show actual number of bytes retrieved
from the buffer.

Show length input

Enables inport so you can vary the number of bytes requested
per call.

Maximum length of data
Set this as required up to the maximum buffer size. You can
set receive and transmit buffer size (up to a maximum of 256
bytes) within the C166 Resource Configuration object. See
“Asynchronous/Synchronous Serial Interface Configuration
Parameters” on page 7-14.

Sample time
The time interval between samples. The default is 1. To inherit
the sample time, set this parameter to - 1. See “Specifying Sample
Time” in the Simulink documentation for more information.
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Purpose

Library

Description

Data ,org
Transmit

Serial Transmit

Configure C166 microcontroller for serial transmit

Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library/ Asynchronous/Synchronous Serial Interface

The Serial Transmit block transmits bytes over the C166 microcontroller
Synchronous/Asynchronous Serial Interface ASCO. You can use it either
to transmit a fixed number of bytes, or by enabling the second input,
transmit a variable number of bytes each time this block is called.

When the block is called, the specified number of bytes are placed in a
FIFO buffer that is internal to the device driver. If this buffer is already
full, or if the number of spaces available is too few, then not all of the
bytes requested will actually be queued for transmit; in this case, the
number of bytes actually transmitted can be determined from block
output.

Once bytes are queued for transmit, they will be sent as fast as possible
by the serial interface hardware with no further intervention required
by the main application. Note that after each byte is sent, a Peripheral
Event Controller (PEC) interrupt is generated to fetch the next byte
from the internal buffer. The PEC interrupts are extremely fast and
have minimal effect on the rest of the application.

To configure the serial interface bit rate, buffer size, PEC interrupt
priority, and other parameters, see “Asynchronous/Synchronous Serial
Interface Configuration Parameters” on page 7-14.



Serial Transmit

Note If your model contains a serial transmit or receive block, it is not
possible to perform on-chip debugging over the same serial interface.
Attempting to use the debugger in this case causes an error. If you
need to debug an application that includes the serial transmit and
receive blocks, you must run the debugger using a hardware simulator;
alternatively, it may be possible to run your debugger on-chip without
using the serial interface, for example if debugging over CAN is
available. See “Starting the Debugger on Completion of the Build
Process” on page 2-12.

Block Inputs and Outputs

The first input contains the data to be transmitted; this input signal
may be either a vector or scalar with data type uints.

The optional second input must be a scalar and may be used to control
the number of bytes transmitted. The number of bytes to transmit
should not be greater than the width of the first input signal.

The block output port actual number of bytes output gives the
number of bytes queued for transmit. If there was sufficient space in
the buffer, this number will be equal to the requested number of bytes
to transmit.
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Sample time
The time interval between samples. To inherit the sample time,

leave this parameter at the default -1. See “Specifying Sample
Time” in the Simulink documentation for more information.

Show length input
Enable/disable the number of bytes to send. If not selected,
the number of bytes sent is just the width of the first inport; if
selected, the second input is enabled, which controls the number

of bytes to send.

Show number of bytes sent
Enable/disable the number of bytes actually sent. If selected, this

value is available from the first output.
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Purpose Configure your model and Target Preferences to one of a set of
predefined hardware configurations

Library Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library/ Utilities

Description

Switch Target
Configuration

Switch Target
Hardware Configuration

Place the Switch Target Configuration block in your model and
double-click it to run a convenience function that configures your model
and Target Preferences to one of a set of predefined configurations. If
your setup does not correspond to one of the predefined configurations,
you may wish to use the file (c166switchconfig.m) as a template

for setting up your own customized configurations. The predefined
configurations include settings for

¢ Phytec phyCORE-C167CS (RAM) [2]

¢ Phytec phyCORE-C167CS (flash)

¢ Infineon XC167CI Starter Kit

¢ Phytec phyCORE-ST10F269

¢ Phytec kitCON-C167CR (RAM)

e Phytec kitCON-C167CR (flash)
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Purpose
Library

Description

Output the Bus Off or Error Warning state of a CAN node on XC16x
variants of the Infineon C166 microprocessor

Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library/ TwinCAN Interface

The TwinCAN Bus Status block is for the TwinCAN interface and
performs the same functions as the CAN Bus Status block. For block
parameter descriptions, see the CAN Bus Status reference page.



TwinCAN Receive

Purpose
Library

Description

Receive CAN messages via the TwinCAN module on XC16x variants of
the Infineon C166 microprocessor

Embedded Target for Infineon C166 Microcontrollers/ C166 Driver
Library/ TwinCAN Interface

The TwinCAN Receive block receives CAN messages from a TwinCAN
module. The TwinCAN Receive automatically reserves one of the
buffers on the TwinCAN module. The TwinCAN Receive block has

two outputs: a data output and a function call trigger output. The
TwinCAN Receive block polls its message buffer at a rate determined
by the block’s sample time. When the TwinCAN Receive block detects
that a message has arrived, the function call trigger is activated. You
should use a function call subsystem, activated by the trigger, to decode
the message available at the TwinCAN Receive block data output.

This block has the same parameters as the CAN Receive block, except
there is no option to Automatically select buffer or Buffer number.
For block parameter descriptions, see the CAN Receive reference page.
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Purpose
Library

Description

Reset a CAN node on XC16x variants of the Infineon C166
microprocessor

Embedded Target for Infineon C166 Microcontrollers/C166 Driver
Library/TwinCAN Interface

The TwinCAN Reset block is for the TwinCAN interface and performs
the same functions as the CAN Reset block. For block parameter
descriptions, see the CAN Reset reference page.
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Purpose
Library

Description

Transmit CAN messages from the TwinCAN module on XC16x variants
of the Infineon C166 microprocessor

Embedded Target for Infineon C166® Microcontrollers/ C166 Driver
Library/ TwinCAN Interface

The TwinCAN Transmit block transmits a CAN message onto the CAN
bus. Two modes of transmission are available with the CAN Transmit
block, as described below.

The first transmit mode is to use a dedicated CAN buffer; in this case,
messages to be transmitted are loaded directly into a CAN buffer
that is used exclusively by the block. No queue is used, which means
that in case the previous message has not been transmitted, it will
be overwritten by the new one. This transmit mode does not use
interrupts. An advantage of using the dedicated buffer mode is that
there is minimal delay in transmitting high-priority messages.

The second transmit mode is to use a First In First Out (FIFO) queue
with dedicated buffer. In this mode, messages are placed in a queue
and then transmitted on a first in, first out basis. This mode is useful
if several messages, possibly with the same CAN identifier, must be
transmitted in sequence; this may be a requirement if CAN is being
used for data acquisition.

The TwinCAN Transmit block should be connected to CAN Message
Packing/Unpacking blocks. Do not ground the block or leave it
unconnected.
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Dialog
Box
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[C]Block Parameters: TwinCAN Transmit 27| x|

—LC166 TwinCAM Transmit [mazk] [link]

Tranzmitz a CAM meszage via the zelected TwinCAN module.

—Parameters

TwinCAN Node: [EESGEGCG— - |

Transmit mode: I Direct transmizzion with dedicated buffer

Buffer selection: | Aptomatic: LI
Buffer number [0..31];
o

S ample time:

[

ok Cancel Help Apply

TwinCAN Node
Select node A or node B.

Transmit mode
Select one of the modes described above: direct transmission with
dedicated buffer, or FIFO queue with dedicated buffer.

Buffer selection
Choose either automatic or manual selection of the hardware
buffer number.

Buffer number [0..31]
This option is available only if the buffer selection is available and
set to manual. You must select a buffer number between 0 and 31.
Note if more than one message is ready to be transmitted, then
the one in the lower buffer number will be sent first. Select buffer
numbers such that the higher the message priority, the lower



TwinCAN Transmit

the buffer number. Note that the hardware buffers are shared
between node A and node B of the TwinCAN module.

Sample time
Choose -1 to inherit the sample time from the driving blocks.
The TwinCAN Transmit block does not inherit constant sample
times and runs at the base rate of the model if driven by invariant

signals.
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